Contents

CHAPTER 1 ABOUT BRAINWARE DISTILLER ............................................................... 7
CHAPTER 2 SYSTEM REQUIREMENTS ................................................................. 8
2.1 Operating Systems ....................................................................................... 8
2.2 Brainware Distiller Database ....................................................................... 8
2.3 IIS ............................................................................................................... 8
2.4 Scripting components .................................................................................. 8
CHAPTER 3 HARDWARE REQUIREMENTS ......................................................... 9
3.1 Network Infrastructure ................................................................................ 9
3.2 Hardware and Software Factors ................................................................ 9
3.3 Hardware Estimate – 500 PPD ................................................................... 10
   3.3.1. Introduction – AP Project ................................................................. 10
   3.3.2. Hardware Estimate – File System (Excl. Web Verifier & Database) . 10
   3.3.3. Hardware Estimate – SQL Server Database (Excl. Web Verifier) . 11
   3.3.4. Hardware Estimate – Entire Application Suite ......................... 11
   3.3.5. Hardware Estimate – Typical Development Environment .......... 12
3.4 Hardware Estimate – 4000 PPD .................................................................. 12
   3.4.1. Introduction – AP Project ................................................................. 12
   3.4.2. Hardware Estimate – File System (Excl. Web Verifier & Database) . 13
   3.4.3. Hardware Estimate – SQL Server Database (Excl. Web Verifier) . 13
   3.4.4. Hardware Estimate – Entire Application Suite ......................... 14
   3.4.5. Web Verifier Server Hardware Sizing – Additional Information .... 15
3.5 Infrastructure Constraints .......................................................................... 16
   3.5.1. OCR Performance ............................................................................. 16
   3.5.2. Firewalls .......................................................................................... 16
3.6 RTS Remote Administration MMC .............................................................. 16
CHAPTER 4 PRE-INSTALLATION OF BRAINWARE DISTILLER ....................... 18
4.1 Before Installing Brainware Distiller .......................................................... 18
   4.1.1. Installation Checklist ....................................................................... 18
4.2 Backward Compatibility with Other Brainware Applications .................... 19
4.3 Brainware Distiller License File .................................................................. 19
4.4 Brainware Distiller Database Checklist ...................................................... 19
   4.4.1. Brainware Distiller Database .......................................................... 19
   4.4.2. Brainware Distiller SQL Server Checklist .................................... 20
   4.4.3. Brainware Distiller ORACLE Checklist ....................................... 20
4.5 Upgrading from Previous Versions of Brainware Distiller ....................... 20
   4.5.1. Brainware Distiller Versions 1.3x and 2.x ....................................... 20
   4.5.2. Upgrading from Version 5.3 ............................................................ 21
   4.5.3. Upgrading from previous versions ................................................ 21
4.6 Removing Brainware Distiller Versions 3.0, 4.0, and 4.1 ............................. 21
CHAPTER 5 INSTALLING BRAINWARE DISTILLER ........................................... 22
5.1 Software Installation .................................................................................... 22
   5.1.1. Selecting Custom Installation ....................................................... 24
   5.1.2. Program Folder and Auto Update ................................................ 26
   5.1.3. Finishing Typical and Custom Installations .................................. 27
   5.1.4. Brainware Distiller Database Setup ............................................. 29
   5.1.5. Completing the Brainware Distiller Setup ..................................... 32
5.2 Manually Creating Database Objects (post install) .................................... 34
5.3 Configuring the Brainware Distiller database (post install) ....................... 35
5.4 Cedar Workflow History Wrapper Component ......................................... 36
5.5 Installing Brainware Distiller in a Workgroup Configuration .................. 36
5.6 Installing Brainware Distiller in Standalone Mode .................................... 37
5.7 Checking the Installation .......................................................................... 38
CHAPTER 6  CONFIGURING APPLICATION .............................................................. 69
   6.1  Configuring Application ............................................................................. 69
       6.1.1.  Configuring Brainware Distiller Database connection string .............. 69
       6.1.2.  Setting path to license file ................................................................. 69
       6.1.3.  Enable HTTP compression for IIS 6.0 and IIS 7.0 .............................. 69
   6.2  Server Security Configuration .................................................................... 69
       6.2.1.  Registering COM components ............................................................ 69
       6.2.2.  Setting Permissions for Brainware projects execution ......................... 73
       6.2.3.  Encrypting sections with aspnet_regiis tool ....................................... 73
   6.3  Client Security Configuration ..................................................................... 74
   6.4  Configuring Windows Authentication for Web Verifier .............................. 76
       6.4.1.  For IIS 7.0 .......................................................................................... 76
       6.4.2.  For IIS 6.0 .......................................................................................... 77
       6.4.3.  Changes to Web.config File ................................................................. 83
       6.4.4.  Reverting Back to Standard Authentication ......................................... 84
   6.5  Configuring SSL for Web Verifier ............................................................. 84
   6.6  Configuring Additional Languages ............................................................. 84
   6.7  Virus Check ............................................................................................... 84
   6.8  Enabling New Columns for Batch View ..................................................... 84
   6.9  Changing Custom Column Names .............................................................. 85
       6.9.1.  Custom Column Names for Web Verifier ............................................ 85
       6.9.2.  Custom Column Names for Thick Verifier Client .................................. 86

CHAPTER 7  SECURITY ....................................................................................... 88
   7.1  Brainware Distiller Security ........................................................------------ 88
       7.1.1.  Project Security .................................................................................. 88
       7.1.2.  Project & Windows Authentication Security ....................................... 88
   7.2  File System Security .................................................................................. 89
   7.3  Access to Project Data ............................................................................... 90
   7.4  Accounts and File Access Security ............................................................ 91
   7.5  Configuring the Service Account for Brainware Distiller ............................. 92
       7.5.1.  Running Brainware Distiller on a Domain Network .............................. 92
       7.5.2.  System Monitoring ............................................................................. 93
       7.5.3.  Email Importing and Service User Accounts ...................................... 93

CHAPTER 8  CONFIGURING RUNTIME COMPONENTS ........................................ 94
CHAPTER 9  AUTO-UPDATE OF BRAINWARE DISTILLER VERIFIER & RUNTIME SERVER SOFTWARE VERSIONS .......................................... 101

9.1  Description ................................................................. 101
9.1.1.  How the Automatic Update Works ......................... 101
9.1.2.  Configuring Auto Update in Brainware Distiller Setup ...... 102
9.2  Usage ............................................................................ 103

CHAPTER 10  ENABLING ADDITIONAL OCR ENGINE LANGUAGES ...................... 105

10.1  To Enable a Language for an OCR Engine ..................... 105
10.2  To add Input Language for Windows 7 .......................... 105
10.3  To add Input Language for Windows XP ....................... 105
10.3.1.  To add Input Language for Windows Vista .......... 106
10.3.2.  To add Input Language for Windows 2008 .............. 106
10.3.3.  To add Input Language for Windows 2003 .......... 106

CHAPTER 11  WORKAROUNDS ........................................................................ 107

11.1  General Support Notice on PDF ........................................ 107
11.1.1.  Embedded Fonts in PDF Files Are Not Supported ... 107
11.1.2.  Overview .................................................................... 107
11.1.3.  Embedded Fonts in PDF Files and Brainware Distiller Support .... 108
11.1.4.  How to Locate Problematic PDF Files with Unmappable Encodings ...... 108
11.1.5.  How to Avoid Creating Problematic PDF Files – ToUnicode Map ... 108
11.1.6.  Available Workarounds ................................................ 108
11.2  Acrobat PDFMaker 9.0 for Microsoft Outlook .................. 109
11.2.1.  Overview ............................................................. 109
11.2.2.  PDF Files Created in Outlook via Acrobat PDFMaker 9.0 for Microsoft Outlook ... 109
11.2.3.  How to Locate Portfolio PDF Files .............................. 109
11.2.4.  Available Workarounds ................................................ 109
11.3  Display and Conversion Problems with Character Width or Overlapping Text ......................................................... 110
11.3.1.  Character Width and Overlapping Text in Embedded Fonts ....................... 110
11.4  JBIG2 Support within Brainware Distiller – Gray X PDFs .......... 110
11.4.1.  Overview .................................................................... 110
11.4.2.  How to Determine if a PDF is using JBIG2 Compression .......... 110
11.4.3.  JBIG2 and Brainware Distiller Support .......... 111
11.4.4.  Available Workarounds ................................................ 111
11.5  Adobe XML Forms Architecture (XFA) PDF Files Are Not Supported .......... 111
11.5.1.  Overview .................................................................... 112
11.5.2.  Adobe XML Forms Architecture PDF Files and Brainware Distiller Support ...... 112
11.5.3.  How to Identify an Adobe XML PDF File ................... 112
11.5.4.  Available Workarounds ................................................ 112
11.6  Oversized PDF Files Are Not Supported ...................... 112
11.6.1.  Overview ............................................................. 113
11.6.2.  How to Identify an Oversized PDF File ...................... 113
11.6.3.  Available Workarounds ................................................ 113
11.7  Performance of ASE Update for ORACLE / SQL Server ............... 114
11.7.1.  Overview ............................................................. 114
11.7.2.  Available Workarounds ................................................ 114
11.8  Running Multiple Web Verifier and RTS instances ............. 114

Brainware Distiller  Page 5 of 131
Chapter 1  About Brainware Distiller

Brainware Distiller is a product suite designed by Brainware, Inc., to automatically process incoming documents. Brainware Distiller works with any document that is electronically available including scanned images, faxes, e-mails, and files. Brainware Distiller automatically classifies these documents and extracts meaningful information from them.

Brainware Distiller uses a trainable, self-learning algorithm that minimizes user definition and intervention tasks. The product is based on Brainware's award-winning Brainware technology.

Within the Brainware Distiller suite, Brainware Distiller Designer enables you to customize the automatic processing of incoming documents, for example, which document classes are relevant in your enterprise as well as which information is to be extracted from the classified documents. All custom settings are saved in a Brainware Distiller project file.

To process large volumes of documents, Brainware Distiller organizes documents into batches, which are defined in the Brainware Distiller project file. The project files and stored settings are automatically forwarded to Brainware Distiller Runtime Server for production processing.

Brainware Distiller Runtime Server runs unattended as a server process in the background. Several mechanisms ensure that the system is stable, meaning that it can automatically recover from most error situations. Multiple instances of Brainware Distiller Runtime Server can be started simultaneously in a network or on a single machine. These instances cooperate and allow for optimal load distribution.

Batches that cannot be automatically processed in their entirety by Brainware Distiller Runtime Server are forwarded to the quality assurance application Brainware Distiller Verifier for manual correction.

An application module to allow users to verify documents with no software installed on the client side. The Web Verifier application can be used via Internet Explorer on any client machine to verify documents. This requires installation and configuration of the project and batches on the database platform. From version 5.1, Brainware Distiller features a newly implemented Brainware Distiller database platform for Brainware Distiller applications. It is possible to store project and authentication information in the Brainware Distiller database. This solution allows for central management of storage and backup and thus provides for easier security, better connectivity of your applications, and higher flexibility of your personnel.
Chapter 2  System Requirements

2.1  Operating Systems

Using Brainware Distiller requires a complete and successful installation of the software on a server or workstation running one of the following 32 or 64 bit operating systems:

- Microsoft Windows XP Professional Service Pack 2 or later.
- Microsoft Windows Vista
- Microsoft Windows 7

2.2  Brainware Distiller Database

The Web Verifier application module requires central management of project data in a database. The Brainware Distiller database has been certified to run on the following database platforms:

- Microsoft SQL Server 2005 Enterprise
- Microsoft SQL Server 2008 Enterprise
- Microsoft SQL Server 2008 R2
- ORACLE 10g R2
- ORACLE 11g R2

Using Brainware Distiller will require .NET Framework 3.5 SP1 installed on the Brainware Distiller server or workstation.

2.3  IIS

Using Brainware Distiller 5.4 SP1 will require the following software applications installed on the server:

- Internet Information Server
- .NET Framework 3.5 SP1

For the client browser version side, Internet Explorer 8 has been certified with Brainware Distiller 5.4 SP1 application.
VMware ESX 4.1 is certified.

2.4  Scripting components

Brainware Distiller has been certified for the following supported Scripting component version:

- WinWrap version 9.0.0.56
Chapter 3  Hardware Requirements

Before Brainware Distiller can be implemented, the underlying network must meet certain minimum platform and environment requirements.

This section includes information about, and instructions for, configuring basic network components.

3.1 Network Infrastructure

The technology infrastructure underlying Brainware Distiller consists of a set of scalable applications and services running on Microsoft Windows operating systems. These applications and services are deployed on a set of high-performance Intel-compatible servers and workstations.

Clients are supported on Intel-compatible workstations running 32 or 64-bit Microsoft operating systems: Windows XP Professional SP2, Windows 7, and Windows Vista.

Brainware Distiller is a distributed two-tier application that is typically deployed across multiple Windows Server operating systems. These applications provide core system services when connected using an unimpeded high-speed, low-latency network infrastructure, such as Fast Ethernet (100BaseTX), using TCP/IP.

3.2 Hardware and Software Factors

When implementing a Brainware Distiller Project, there are a number of dependencies which influence the hardware requirements for a Brainware Distiller solution.

This information is typically gathered during the requirements analysis phase of the project and used as a guideline to aid the project team members responsible for sizing the hardware and software for the implementation.

The hardware requirements provided in this document can be used as a guideline; it is not a recommended or required hardware configuration for an implementation of Brainware Distiller. The actual hardware and software configuration for an installation should be based on the client's requirements.

Some factors to consider when sizing the hardware for a production environment are:

- Input volume – The number of documents/pages to process on a daily basis
- Completion Time – The required amount of time from when the document is scanned into the system, to when it is exported out of Brainware Distiller
- Complexity of input documents (single or multi-page TIFF, scanned resolution, document size, number of pages OCR’ed per document, etc.)
- Output requirements (data extraction, validation, and export, number of documents processed per day, etc.)
- Complexity of workflow customization (scripting)
- Third-party software integration requirements (ORACLE Financials, JD Edwards, SAP, CRM systems, etc.)
- Backup strategy
- Disaster recovery (backup, fault tolerance, up time, etc.)
- Network operating system platform
- Network environment
- Room for growth (increased in input/output and other system requirements)
• Users – The number of users (Web Verifier versus Verifier)
• Batch Retention Time – The time for a batch of documents to remain in the system after export
• Number of projects – Number of Brainware Distiller projects (per country, per solution, etc)
• Components Installed – Other Brainware components such as WF-Brainware Distiller and Visibility or databases would likely be installed on another server. [It is recommended that for a production environment, Brainware products should be installed on separate servers.]

The following sections of the document are representations of some Hardware Scenario configuration.

3.3 Hardware Estimate – 500 PPD

3.3.1. Introduction – AP Project

Based on the standard Brainware AP Project, the following production system is recommended.

Assumptions:
• 1-3 page TIFF documents
• Document resolution of 300 dpi
• Average TIFF size of approximately 40KB
• Average WorkDoc size of approximately 21KB
• Minimum data extraction and validation (as per the project)
• Project size of less than 5 MB and less than 10 classes
• Cleanup of exported batches (1-3 days)

*Note: Disk space requirement is implementation dependent; variables such as document complexity, scanned resolution, and document volume help determine the amount of disk space for a project. For example, persistent storage of TIFF images requires approximately 70 KB per page. In addition, approximately 100 KB per document are required to temporarily store WorkDocs with OCR results. If PDF file generation is enabled, another 100 KB per page are temporarily required.*

3.3.2. Hardware Estimate – File System (Excl. Web Verifier & Database)

<table>
<thead>
<tr>
<th>Machine Role</th>
<th>Hardware</th>
<th>Software Needed</th>
</tr>
</thead>
<tbody>
<tr>
<td>Brainware Distiller Server (Primary)</td>
<td>Required</td>
<td>Windows 2003 Server 32-bit Standard Edition or higher, Windows 2008 Server (Ipv4) 32 or 64 bit, or Windows 2008 R2 with the latest service pack</td>
</tr>
<tr>
<td>- File Repository</td>
<td>- OCR/Classify/Extract</td>
<td>Brainware Distiller Version 5.4 SP1</td>
</tr>
<tr>
<td>- Licensing Server</td>
<td>- Licensing</td>
<td></td>
</tr>
<tr>
<td>Brainware Distiller Designer</td>
<td>Optional</td>
<td>Windows XP Professional SP2, or Windows VISTA or Windows 7 (32 and 64 bit)</td>
</tr>
<tr>
<td>Project Design</td>
<td>Pentium IV Class, 2.4 GHz CPU (2.8 GHz recommended)</td>
<td>Brainware Distiller Designer Version 5.4 SP1</td>
</tr>
<tr>
<td>Class Training</td>
<td>1 GB RAM</td>
<td></td>
</tr>
<tr>
<td>Brainware Distiller Verifier, Advanced Verifier &amp;</td>
<td>Required</td>
<td>Windows XP Professional SP2, or Windows VISTA or Windows 7 (32 and 64 bit)</td>
</tr>
<tr>
<td></td>
<td>Pentium Class, 2.4 GHz CPU (2.8 GHz recommended)</td>
<td></td>
</tr>
</tbody>
</table>
### Machine Role | Hardware | Software Needed |
--- | --- | --- |
Learnset Manager Data Verification | recommended) 1 GB RAM 20 GB hard drive (10 GB minimum) | Brainware Distiller Verifier Version 5.4 SP1 |
Brainware Distiller Remote Admin RTS Remote Administration | Optional Pentium Class, 2.4 GHz 1 GB RAM [HD – Application install only ≤500Mb] | Windows XP Professional SP2, or Windows VISTA or Windows 7 (32 and 64 bit) Brainware Distiller Version 5.4 SP1 RTS Remote Admin MMC Snap-in |

Table 3-1: Recommended Configuration

### 3.3.3. Hardware Estimate – SQL Server Database (Excl. Web Verifier)

| Machine Role | Hardware | Software Needed |
--- | --- | --- |
Brainware Distiller Server (Primary) - File Repository - OCR/Classify/Extract - Licensing Server Database Server | Required Quad Core Xeon Class, 2.4 GHz CPU 4 GB RAM 100Gb Hard Disk Space Brainware Licensing Dongle | Windows 2003 Server 32-bit Standard Edition or higher, Windows 2008 Server (ipv4) 32 or 64 bit, or Windows 2008 R2 with the latest service pack SQL Server 2005 and above or ORACLE 10 and above .NET Framework 3.5 SP1 Brainware Distiller Version 5.4 SP1 |
Brainware Distiller Designer Project Design Class Training | Optional Pentium IV Class, 2.4 GHz CPU (2.8 GHz recommended) 1 GB RAM 10 GB hard drive (20 GB hard drive recommended) | Windows XP Professional SP2, or Windows VISTA or Windows 7 (32 and 64 bit) .NET Framework 3.5 SP1 Brainware Distiller Designer Version 5.4 SP1 |
Brainware Distiller Verifier, Advanced Verifier & Learnset Manager Data Verification | Required Pentium Class, 2.4 GHz CPU (2.8 GHz recommended) 1 GB RAM 10 GB hard drive (10 GB minimum) | Windows XP Professional SP2, or Windows VISTA or Windows 7 (32 and 64 bit) .NET Framework 3.5 SP1 Brainware Distiller Verifier Version 5.4 SP1 |
Brainware Distiller Remote Admin RTS Remote Administration | Optional Pentium Class, 2.4 GHz 1 GB RAM [HD – Application install only ≤500Mb] | Windows XP Professional SP2, or Windows VISTA or Windows 7 (32 and 64 bit) .NET Framework 3.5 SP1 Brainware Distiller Version 5.4 SP1 RTS Remote Admin MMC Snap-in |

Table 3-2: Recommended Configuration

*Note: When using ORACLE as a database, it is advised to have an ORACLE client installed on any workstation/server where Brainware Distiller communicates with the database (Designer, Verifier, etc).*

### 3.3.4. Hardware Estimate – Entire Application Suite

The entire application suite comprises of Brainware Distiller Runtime Server, Web Server, and Database.

| Machine Role | Hardware | Software Needed |
--- | --- | --- |
Brainware Distiller Server (Primary) - File Repository - OCR/Classify/Extract - Licensing Server Database Server | Required Quad Core Xeon Class, 2.8 GHz CPU 8 GB RAM 100Gb Hard Disk Space Brainware Licensing Dongle | Windows 2003 Server 32-bit Enterprise Edition or higher, Windows 2008 Server (ipv4) 32 or 64 bit, or Windows 2008 R2 with the latest service pack SQL Server 2005 and above or ORACLE 10 and above |
<table>
<thead>
<tr>
<th>Machine Role</th>
<th>Hardware</th>
<th>Software Needed</th>
</tr>
</thead>
<tbody>
<tr>
<td>Web Server</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Brainware Distiller Designer</td>
<td>Optional</td>
<td>Pentium IV Class, 2.4 GHz CPU (2.8 GHz recommended) 1 GB RAM 10 GB hard drive (20 GB hard drive recommended)</td>
</tr>
<tr>
<td>Brainware Distiller Verifier, Advanced Verifier &amp; Learnset Manager Data Verification</td>
<td>Optional</td>
<td>Pentium Class, 2.4 GHz CPU (2.8 GHz recommended) 1 GB RAM 20 GB hard drive (10 GB minimum)</td>
</tr>
<tr>
<td>Brainware Distiller Web Verifier</td>
<td>Optional</td>
<td>Pentium Class, 2.4 GHz 2GB RAM</td>
</tr>
<tr>
<td>Brainware Distiller Remote Admin RTS Remote Administration</td>
<td>Optional</td>
<td>Pentium Class, 2.4 GHz 1 GB RAM [HD – Application install only &lt;500Mb]</td>
</tr>
</tbody>
</table>

**Table 3-3: Recommended Configuration**

### 3.3.5. Hardware Estimate – Typical Development Environment

A typical development environment consists of one server which processes less than 500 pages per day. The specification below should be sufficient to house the Web Server, Database, and Brainware Distiller Runtime Server.

<table>
<thead>
<tr>
<th>Machine Role</th>
<th>Hardware</th>
<th>Software Needed</th>
</tr>
</thead>
<tbody>
<tr>
<td>Brainware Distiller Server (Primary) - File Repository - OCR/Classify/Extract - Licensing Server - Database Server - Web Server</td>
<td>Required</td>
<td>Quad Core Xeon Class, 2.8 GHz CPU 8 GB RAM 100Gb Hard Disk Space Brainware Licensing Dongle</td>
</tr>
</tbody>
</table>

**Table 3-4: Recommended Configuration**

### 3.4 Hardware Estimate – 4000 PPD

#### 3.4.1. Introduction – AP Project

Based on the standard Brainware AP Project, the following production system is recommended.

Assumptions:
Installation Guide  Chapter 3  Hardware Requirements

- 1-3 page TIFF documents
- Document resolution of 300 dpi
- Average TIFF size of approximately 60KB
- Average WorkDoc size of approximately 60KB
- Minimum data extraction and validation (as per the project)
- Project size of less than 5 MB and less than 10 classes
- Cleanup of exported batches (1-3 days).
- All documents are provided at the start of the day

Disk space requirement is implementation dependent; variables such as document complexity, scanned resolution, and document volume help determine the amount of disk space for a project. For example, persistent storage of TIFF images requires approximately 70 KB per page. In addition, approximately 100 KB per document are required to temporarily store WorkDocs with OCR results. If PDF file generation is enabled, another 100 KB per page are temporarily required.

3.4.2. Hardware Estimate – File System (Excl. Web Verifier & Database)

<table>
<thead>
<tr>
<th>Machine Role</th>
<th>Hardware</th>
<th>Software Needed</th>
</tr>
</thead>
<tbody>
<tr>
<td>Brainware Distiller Server (Primary) - File Repository - OCR/Classify/Extract - Licensing Server</td>
<td>Required Quad Core Xeon Class, 2.8 GHZ CPU 8GB RAM 200Gb Hard Disk Space Brainware Licensing Dongle</td>
<td>Windows 2003 Server 32-bit Enterprise Edition or higher, Windows 2008 Server (Ipv4) 32 or 64 bit, or Windows 2008 R2 with the latest service pack. Brainware Distiller Version 5.4 SP1</td>
</tr>
<tr>
<td>Brainware Distiller Designer - Project Design - Class Training</td>
<td>Optional Pentium IV Class, 2.4 GHZ CPU (2.8 GHZ recommended) 1 GB RAM 10 GB hard drive hard drive recommended</td>
<td>Windows XP Professional SP2, or Windows VISTA or Windows 7 (32 and 64 bit). Brainware Distiller Designer Version 5.4 SP1</td>
</tr>
<tr>
<td>Brainware Distiller Verifier, Advanced Verifier &amp; Learnset Manager - Data Verification</td>
<td>Required Pentium Class, 2.4 GHZ CPU (2.8 GHZ recommended) 1 GB RAM 20 GB hard drive (10 GB minimum)</td>
<td>Windows XP Professional SP2, or Windows VISTA or Windows 7 (32 and 64 bit). Brainware Distiller Verifier Version 5.4 SP1</td>
</tr>
<tr>
<td>Brainware Distiller Remote Admin - RTS Remote Administration</td>
<td>Optional Pentium Class, 2.4 GHZ 1 GB RAM [HD – Application install only &lt;500Mb]</td>
<td>Windows XP Professional SP2, or Windows VISTA or Windows 7 (32 and 64 bit). Brainware Distiller Version 5.4 SP1 RTS Remote Admin MMC Snap-in</td>
</tr>
</tbody>
</table>

Table 3-5: Recommended Configuration

3.4.3. Hardware Estimate – SQL Server Database (Excl. Web Verifier)

<table>
<thead>
<tr>
<th>Machine Role</th>
<th>Hardware</th>
<th>Software Needed</th>
</tr>
</thead>
<tbody>
<tr>
<td>Brainware Distiller Server (Primary) - File Repository - OCR/Classify/Extract - Licensing Server - Database Server</td>
<td>Required Quad Core Xeon Class, 2.8 GHZ CPU 8 GB RAM 200Gb Hard Disk Space Brainware Licensing Dongle</td>
<td>Windows 2003 Server 32-bit Enterprise Edition or higher, Windows 2008 Server (Ipv4) 32 or 64 bit, or Windows 2008 R2 with the latest service pack. SQL Server 2005 and above or ORACLE 10 and above .NET Framework 3.5 SP1 Brainware Distiller Version 5.4 SP1</td>
</tr>
<tr>
<td>Brainware Distiller Designer</td>
<td>Optional Pentium IV Class, 2.4 GHZ CPU (2.8 GHZ recommended)</td>
<td>Windows XP Professional SP2, or Windows VISTA or Windows 7 (32 and 64 bit)</td>
</tr>
</tbody>
</table>
### Installation Guide Chapter 3 Hardware Requirements

#### Table 3-6: Recommended Configuration

When using ORACLE as a database, it is advised to have an ORACLE client installed on any workstation/server where Brainware Distiller communicates with the database (Designer, Verifier, etc).

### 3.4.4. Hardware Estimate – Entire Application Suite

The entire application suite comprises of Brainware Distiller Runtime Server, Web Server, and Database.

<table>
<thead>
<tr>
<th>Machine Role</th>
<th>Hardware</th>
<th>Software Needed</th>
</tr>
</thead>
</table>
| **Brainware Distiller Server (Primary)**  
- File Repository  
- OCR/Classify/Extract  
- Licensing Server  
Database Server | Required  
Quad Core Xeon Class, 2.8 GHz CPU  
8 GB RAM  
100Gb Hard Disk Space  
Brainware Licensing Dongle | Windows 2003 Server 32-bit Enterprise Edition or higher, Windows 2008 Server (Ipv4) 32 or 64 bit, or Windows 2008 R2 with the latest service pack  
SQL Server 2005 and above or ORACLE 10 and above  
IIS 6 and above  
.NET Framework 3.5 SP1  
Brainware Distiller Version 5.4 SP1 |
| **Brainware Distiller Web Server** | Required  
Dual Core Xeon Class, 2.8 GHz CPU  
4 GB RAM  
50Gb Hard Disk Space  
30Gb OS Hard Disk Space | Windows 2003 Server 32-bit Standard Edition or higher, Windows 2008 Server (Ipv4) 32 or 64 bit, or Windows 2008 R2 with the latest service pack  
SQL Server 2005 and above or ORACLE 10 and above  
Brainware Distiller Designer  
IIS 6 and above  
.NET Framework 3.5 SP1  
Brainware Distiller Version 5.4 SP1 |
| **Brainware Distiller Designer**  
Project Design  
Class Training | Optional  
Pentium IV Class, 2.4 GHz CPU (2.8 GHz recommended)  
1 GB RAM  
10 GB hard drive (20 GB hard drive recommended) | Windows XP Professional SP2, or Windows VISTA or Windows 7 (32 and 64 bit)  
.NET Framework 3.5 SP1  
Brainware Distiller Designer Version 5.4 SP1 |
| **Brainware Distiller Verifier, Advanced Verifier & Learnset Manager**  
Data Verification | Optional  
Pentium Class, 2.4 GHz CPU (2.8 GHz recommended)  
1 GB RAM  
20 GB hard drive (10 GB minimum) | Windows XP Professional SP2, or Windows VISTA or Windows 7 (32 and 64 bit)  
.NET Framework 3.5 SP1  
Brainware Distiller Verifier Version 5.4 SP1 |
### Hardware Requirements

#### Machine Role

<table>
<thead>
<tr>
<th>Machine Role</th>
<th>Hardware</th>
<th>Software Needed</th>
</tr>
</thead>
<tbody>
<tr>
<td>Brainware Distiller Web Verifier</td>
<td>Optional, Pentium Class, 2.4 GHz 2GB RAM</td>
<td>Windows XP Professional SP2, or Windows VISTA or Windows 7 (32 and 64 bit) Internet Explorer 7</td>
</tr>
<tr>
<td>Brainware Distiller Remote Admin RTS Remote Administration</td>
<td>Optional, Pentium Class, 2.4 GHz 1 GB RAM [HD – Application install only ~500Mb]</td>
<td>Windows XP Professional SP2, or Windows VISTA or Windows 7 (32 and 64 bit) .NET Framework 3.5 SP1 Brainware Distiller Version 5.4 SP1 RTS Remote Admin MMC Snap-in</td>
</tr>
</tbody>
</table>

#### Table 3-7: Recommended Configuration

### 3.4.5. Web Verifier Server Hardware Sizing – Additional Information

Additional Web Server considerations depend on the number of Verifier users.

#### Table 3-8: Recommended Configuration

Factors which influence the metrics are:
- Project size and complexity
- Other software stored on the server
- Third party software integration (e.g. SAP lookups)
- Network connections
- Document Sizes
- Project Type

<table>
<thead>
<tr>
<th>Number of Users</th>
<th>Memory</th>
<th>Processor</th>
</tr>
</thead>
<tbody>
<tr>
<td>Per User</td>
<td>150Mb</td>
<td>Peak Load 100% of a 3GHz CPU</td>
</tr>
<tr>
<td>0-10 Users</td>
<td>4 Gb</td>
<td>Dual Core CPU</td>
</tr>
<tr>
<td>11-20 Users</td>
<td>8 Gb</td>
<td>Quad Core CPU</td>
</tr>
</tbody>
</table>

#### Machine Role

<table>
<thead>
<tr>
<th>Machine Role</th>
<th>Hardware</th>
</tr>
</thead>
<tbody>
<tr>
<td>Brainware Distiller Server (Primary) Project File (.SDP) Batch Directory Stores Images Workdocs Input Directory Learnset License Server</td>
<td>Xeon Class, 2.4 GHz CPU 2 GB RAM Three or more 36 GB (40 GB recommended) + Hot Swappable hard drive RAID Controller (for fault tolerance) Dongle</td>
</tr>
<tr>
<td>Brainware Distiller RTS Performs OCR Classfication Data Extraction Export System Clean-up</td>
<td>Dual Xeon Class, 2.8 GHz CPU 2 GB RAM (1 GB minimum) 40 GB hard drive</td>
</tr>
<tr>
<td>Brainware Distiller</td>
<td>Pentium IV Class, 2.4 GHz</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Software Needed</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows 2003 Server 32-bit, Windows 2008 Server (ipv4) 32 or 64 bit, or Windows 2008 R2 Enterprise Edition with the latest service pack Microsoft .Net Framework 3.5 SP1 Brainware Distiller Version 5.4 SP1</td>
</tr>
<tr>
<td>Windows Server 2003 32-bit Standard Edition, Windows 2008 Server (ipv4) 32 or 64 bit, or Windows 2008 R2 with the latest service pack Microsoft .Net Framework 3.5 SP1 Brainware Distiller Version 5.4 SP1</td>
</tr>
<tr>
<td>(xe Windows 7)Windows XP Professional PS2, or</td>
</tr>
</tbody>
</table>

### 3.5 Infrastructure Constraints

Brainware Distiller has been fully tested and is certified to work in most LAN environments. By adhering to the following infrastructure constraints, you can ensure a smooth implementation of the product suite.

#### 3.5.1. OCR Performance

OCR is a processor-intensive task. To maximize OCR performance, we recommend that only one RTS OCR instance is active per CPU on a production server. Although it is possible to run multiple RTS OCR instances on a single CPU, doing so may impair the performance of OCR and the overall system.

#### 3.5.2. Firewalls

Brainware Distiller is designed to work in a non-encapsulated LAN environment. A non-encapsulated LAN, in this context, is a LAN segment free of impediments such as firewalls and other traffic-filtering devices.

With multi-site network environments, it is the responsibility of the customer’s IT personnel to ensure that an unobstructed communication path exists between the user community and host system.

### 3.6 RTS Remote Administration MMC

You can remotely administer Brainware Distiller Runtime Server, meaning that you can centrally manage multiple Runtime Servers from a single workstation on the network using a management console snap-in called the RTS Remote Administration MMC.

However, to use the RTS Remote Administration MMC snap-in, the administrator workstation must either reside on the same LAN segment as the RTS server services to be centrally administered or, in the case of a sub-netted network, a name resolution system must be in place to allow clients on one subnet to locate resources on another subnet.

Remote Administration by MMC requires one free configurable port number. The default port is 50607.
The Windows service Brainware Distiller Service Manager must be running in order to be able to connect by MMC to the Runtime Server service. Once the service is running, it is possible to start and stop each Runtime Server instance separately.

As long as the configured port is available in any TCP/IP network (or Internet across firewalls) and the main service is running, the MMC can be used to configure and maintain the Runtime Server instances.
Chapter 4 Pre-Installation of Brainware Distiller

When you are ready to install Brainware Distiller, there are several steps you should take to ensure that the installation goes smoothly. This section includes information about the following:

- Backward compatibility with other Brainware applications
- Upgrading from previous versions of Brainware Distiller
- Uninstalling Brainware Distiller Versions 4.x
- Installing Brainware Distiller Version 5.4 SP1 in standalone mode
- Installing Brainware Distiller Version 5.4 SP1
- Checking the installation
- Migrating existing project files to Version 5.4 SP1
- Uninstalling Brainware Distiller Version 5.4 SP1
- Repairing Brainware Distiller Version 5.4 SP1
- Adding or removing product components

4.1 Before Installing Brainware Distiller

Before starting the installation, make sure that you have local administrator rights on the target machine. During the installation, a number of DLLs will be copied to the Windows system directory and registered with the operating system. The Brainware Distiller database will be created on the SQL Server or ORACLE servers. The install process requires administrative privileges and access to the Windows registry.

The installation media contains the following folders:

- \Install contains the setup executables of the Brainware Distiller product suite.
- \Install\doc contains Brainware Distiller product documentation.

4.1.1 Installation Checklist

The checklist below is designed to help you install and configure Brainware Distiller in your environment.

- If you are installing Brainware Distiller in a standalone mode (a non-network test or demo installation,) do only the steps outlined in Chapter 5 Installing and skip the rest of the installation checklist.

- If you are upgrading from a previous version of Brainware Distiller, read section 4.5 Upgrading from Previous Versions of and do the steps outlined in that section before continuing with the installation checklist.

- If your organization uses other Brainware products, read section 4.2 Backward Compatibility with Other Brainware Applications before proceeding with the installation checklist.

- Read Chapter 3 Hardware Requirements.

- Configure the SQL Server / ORACLE software.

- If following the Microsoft recommended resource rights assignment model, create the users and groups.

- Install Brainware Distiller Version 5.4 SP1. (Chapter 5 Installing Brainware Distiller)

- Configure the Runtime Components. (Chapter 8 Configuring Runtime Components)
[92x792]Installation Guide Chapter 4 Pre-Installation

- Configure the Runtime Service Manager (Section 8.2 Configuring the Runtime Service Manager).
- Start the Runtime Service Manager.
- Configure the RTS RemoteAdmin MMC snap-in (Section 8.3 Configuring the RTS RemoteAdmin MMC Snap-in).
- Test the installation (See the Brainware Distiller Runtime Server User Guide).
- Configure license and project settings for an instance. (See the Brainware Distiller Runtime Server User's Guide.)
- Process a batch (minimum workflow steps: OCR, Classification, and Extraction).
- If using Web Verifier, configure the IIS and .NET along with application security. (See Chapter 6 Configuring Application)

4.2 Backward Compatibility with Other Brainware Applications

Brainware Distiller is part of the Brainware line of application suites branded Brainware. These products share common components based on the award-winning Brainware technology.

*Note:* Brainware Distiller Version 5.4 SP1 is fully backward compatible with Version 3.0/4.0/4.1 of Brainware Distiller but not with earlier versions. It is not compatible with versions of Brainware Distiller earlier than 3.0.

If your organization uses Capture (in conjunction with older versions of Brainware Distiller) and you want to upgrade to Brainware Distiller Version 5.4 SP1, you must also upgrade to Capture Version 5.4 SP1.

For earlier versions of Brainware Distiller 3.0 and below, please contact Professional Services to assist in the upgrade of your project(s).

*Note:* Effective immediately, all new Brainware Distiller implementations use the Database option, not the File System option. Release 5.3 SP2 is the last release that supports the File System option. If you want to take full advantage of the new features in versions beyond 5.3 SP2, please upgrade to a Database system.

*Note:* Brainware recommends engaging Professional Services to ensure a successful and smooth installation of the software.

4.3 Brainware Distiller License File

Brainware Distiller version 5.4 SP1 requires a new license file. Please contact Brainware Customer Support (support@brainware.com) to convert your existing license to a version 5.4 SP1 license file.

4.4 Brainware Distiller Database Checklist

4.4.1 Brainware Distiller Database

Brainware Distiller version 5.4 SP1 is able to store the following Brainware Distiller core information directly in the Brainware Distiller database, instead of the file system:

- Documents
- Batches (jobs)
- Images and document files in e-format
- Project references
- Users, groups, roles and relationships
- Verifier configuration (Web Verifier only)
- Batch/Document lock handling
- Application level user licensing

File system functionality is no longer supported. Customers with file system based batches that want to upgrade to versions beyond 5.3 SP2 will be required to upgrade to database based batches.

Prior to installation of Brainware Distiller, some care must be taken to make sure that the appropriate configuration steps have been taken.

4.4.2. Brainware Distiller SQL Server Checklist

Brainware Distiller will need to create the following items prior to the installation of the software:

1. An administrative database account with rights to create, modify, and delete tables. Windows Authentication can be used if the user performing the installation has administrative rights to the database server.
2. A designated user database account which will be used by Brainware Distiller to access the database, add, modify, and delete data. Windows Authentication can be used if the user performing the installation has the appropriate rights to the database server.

4.4.3. Brainware Distiller ORACLE Checklist

Brainware Distiller will need the following items taken care of prior to the installation of the software:

1. Create a new ORACLE instance for Brainware, name it Brainware Distiller.
2. Create a new user called Brainware with a password.
3. Assign sufficient rights to the above user:
   a. Allow for increased growth of data.
   b. Allow for insertion, modification, and deletion of data.
   c. Allow for table, views, etc. creation.
4. Administrative database accounts with rights to create, modify, and delete tables. Windows Authentication can be used if the user performing the installation has administrative rights to the database server.
5. A designated user database account which will be used by Brainware Distiller to access the database, add, modify, and delete data. Windows Authentication can be used if the user performing the installation has the appropriate rights to the database server.

4.5 Upgrading from Previous Versions of Brainware Distiller

4.5.1. Brainware Distiller Versions 1.3x and 2.x

The earlier versions of Brainware Distiller, 1.3x and 2.x, require Professional Services/Brainware assistance in upgrading as there have been several changes in the software architecture.
4.5.2. Upgrading from Version 5.3

The installation process provides a Repair option to upgrade version 5.3 to 5.4. For details refer to the Product migration guide.

4.5.3. Upgrading from previous versions

Due to the Brainware Distiller database focusing of version 5.4 SP1 which has to be established during the setup process, the previous Brainware Distiller version has to be uninstalled prior to installation of version 5.4 SP1.

4.6 Removing Brainware Distiller Versions 3.0, 4.0, and 4.1

It is recommended to uninstall any previous versions of Brainware Distiller prior to installing Brainware Distiller 5.4 SP1.

The uninstaller may not remove several registry entries and subdirectories adequately. For this reason, they must be removed manually. Please follow the procedure below to properly remove the older version of Brainware Distiller before installing Version 5.4 SP1.

**Important:** Following these instructions will remove some of the files and registry entries that are used by other Brainware products (Steps 7 below) and render the products unusable. If you already have other Brainware products installed, expand the affected folders and registry keys and delete only the subfolders and sub-registry values that are specific to Brainware Distiller.

To remove previous versions of Brainware Distiller:

1) Select Start>Settings>Control Panel.

2) Launch the Add/Remove Program wizard.

3) On the Currently Installed Programs list, select the Brainware Distiller version you want to remove.

4) Click Change/Remove.

5) Follow the on-screen instructions to remove the product.

6) Click Finish.

7) Save any permanent license files in the …\<Application folder>\Component\Cairo directory before deleting the …\<Application folder> folder.

   Save the FineReader FRELF file if FineReader 8.1 or FineReader 10 is used.

   If there are other Brainware products installed, do not delete the …\Cairo and …\Cedar sub-directories and any registry keys specific to those applications. Also, if there are any project files stored below the …\<Application folder> folder, you should move them before deleting the folder.)

8) Remove the …\<Application folder> subdirectory.

9) Restart the machine.

10) Install Brainware Distiller Version 5.4 SP1.

**Note:** Brainware Distiller Runtime Server Settings and Verifier Settings files can be reused in the new version. It is recommended to save these prior to un-installation and reuse them when configuring a new Runtime Server or Verifier Workstation.
Chapter 5  Installing Brainware Distiller

5.1  Software Installation

_Not_ Note: You must first install .NET Framework 3.5 SP1 prior to installing Brainware Distiller.

To install Brainware Distiller:

1) Browse to the installation folder and run setup.exe.

2) English and German are the supported installation languages. The installer gets its language settings from the regional settings of the operating system. The installation defaults to English if a language other than English or German is detected.

3) Make sure that all Brainware Distiller applications are closed.

Figure 5-1: Active Applications warning window
4) Click *Next* to continue.

5) Select the installation type: *Complete* or *Custom*

   **Complete:** Installs the most common options:
   - Brainware Distiller Designer, Runtime Server, and Thick/Web Verifier.
   - Default Folder: *SystemDrive:*\Program Files\Brainware.
   - Default Program Group: Brainware Distiller.

   **Custom:** It enables you to install only the components you will use.
6) For a complete installation choose Complete and press Next. This will run the typical installation and install all optional components. Go to section 5.1.2 Program Folder and Auto Update to complete the setup. By default, the Demo License is included.

7) For a custom installation choose Custom and press Next. Read the next chapter for details.

5.1.1. Selecting Custom Installation

If you selected Custom on the Setup Type screen, you can select the installation directory, the features and other components.
For a custom installation:

1) First choose the installation directory.

2) In Feature Selection dialog box, select the desired applications.

3) In the OCR components list, you can select the optional components used for Barcode recognition and Handprint OCR.

   Only components selected during the installation will be available. However, you can
always add more components later. (See section 5.11 Adding or Removing Version 5.4 SP1 Components).

4) Select or deselect Demo Project if this is a custom installation.
5) Click Next.

Note: Optional components must be acquired separately and require separate licensing.

<table>
<thead>
<tr>
<th>Optional components</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Cleqs Barcode Engine:</td>
<td>Reads handwritten and machine-printed data and barcode information. It reads 18 types of barcodes.</td>
</tr>
<tr>
<td>FineReader8.1 OCR Engine:</td>
<td>Converts paper-based or scanned images into editable text. Supports English, German, Italian, French, and Spanish.</td>
</tr>
<tr>
<td>FineReader10 OCR Engine:</td>
<td>Now supporting Chinese/Korean/Japanese characters in addition to English, German, Italian, French, and Spanish. Converts paper-based or scanned images into editable text.</td>
</tr>
<tr>
<td>Kadmos5 OCR Engine:</td>
<td>Used for handwriting recognition.</td>
</tr>
<tr>
<td>Recognita Engine:</td>
<td>Supports 75 languages and more than 100 scanner models.</td>
</tr>
</tbody>
</table>

Table 5-1: List of available OCR components

5.1.2. Program Folder and Auto Update

For either a typical or custom installation:

1) Select the desired applications for the Auto Update Feature. Furthermore you can enter the path for the Shared Network Updates Directory here. (See Chapter 9)
2) Click Next.

3) In the Select Program Folder screen, select an existing program folder or a new folder for the Brainware Distiller program icons. The default setting is Brainware\Brainware Distiller.

4) Click Next.

5) Verify that the selected components are listed on the Selected Install Options dialog box and click Next.

5.1.3. Finishing Typical and Custom Installations

Verify that the selected components are listed on the Selected Install Options dialog box and click Next.
6) At the WIBU-KEY Runtime-Kit pop-up window, click Yes to install the Runtime-Kit.

7) The setup creates several subdirectories below the installation directory:
   - `\Components\Cairo` contains the Brainware base components for imaging and recognition. In a complete installation there are several subdirectories with third party libraries: Accusoft, Cleqs Barcode, FineReader, Kadmos, Recognita, INSO, and LDF. This directory also contains the master license file.
   - `\Components\Cedar` contains the Brainware base components for document analysis. There is one subdirectory for each supported language and a subdirectory with a third party library, FindLink.
   - `\Components\Tools` contains the installation log file, component version information, and other tools/utilities for Brainware Distiller.
   - `\Projects` contains demo projects.
- `\Brainware Distiller\bin` contains the Brainware Distiller Designer executable DstDsr.exe, the Brainware Distiller Runtime Server executables DstMgr.exe and DstHost.exe, the Brainware Distiller Supervised Learning Manager executable DstSlm.exe, and the Brainware Distiller Verifier executable DstVer.exe. It also contains the settings files.
- `\Brainware Distiller\bin\Log` contains the log files of the Brainware Distiller Runtime Server.
- `\Brainware Distiller Web Server` contains the Brainware Distiller Web components, the Web.Config file, and other web libraries used by the Web Verifier.

### 5.1.4. Brainware Distiller Database Setup

8) Now, the dialog box for the Brainware Distiller Database setup appears.

![Database Setup Options dialog box](image)

9) After selection of the desired server, click Next. Go to number 13) for the Oracle configuration or to number 10) for SQL configuration. If you want to end the installation without installing the Database, go to section 5.1.5 Completing the Brainware Distiller Setup.

For SQL Server:

10) Enter the name of your Database server. You will find it in the SQL Server Configuration Manager.

   The setup will search for the SQL Server, connects with it and creates a new database with the table name Brainware Distiller.
Figure 5-12: Database Server Information for SQL Server dialog box

**Very Important!**

*Please note, if you already have a Brainware Distiller Database installed, this Database will be overwritten by this installation process. The following window appears in this case:*

Figure 5-13: existing Brainware Distiller Database detected dialog box

*If you want to save your existing Database, back it up before continuing. This applies for the installation of a new version on the same machine.*

*If you want to keep your current installation but want to install Brainware Distiller e. g. on an additional Runtime Server machine, you can keep your existing Database by copying all of*
the configuration files (web.config and .config files in \Brainware Distiller\bin) from the existing installation folder Brainware Distiller\bin to the new setup folder.

11) Enter your logon information for the Database or use the Windows Authentication. You will also have to setup logon information for the newly implemented Database on the SQL Server level.

![Figure 5-14: Selection for Windows Authentication](image)

If you already have created login credentials for the server, you can enter them in this dialog box.

![Figure 5-15: Administrative credentials for SQL Server dialog box](image)

12) Click Next.

For Oracle:

13) Provide your login credentials. This will need to be an Administrative account which had access to create tables, views, etc in the database.
14) Enter the name of your Database server. As default, it is your Machine name/Server name.

15) Click Next.

5.1.5. Completing the Brainware Distiller Setup

16) The final part of the installation confirms components that have been installed.
17) Select Next to continue.

18) You will be presented with a screen to confirm if you want to have desktop icons created for Brainware Distiller application. Tick the checkbox if you want Desktop icons.

19) Select Finish, to complete the installation.
5.2 Manually Creating Database Objects (post install)

It is also possible to install the database manually. This can be due to corporate policies. In such an instance, the following steps can be taken to install and configure the database manually:

1) Launch Windows Explorer and navigate to the installation folder. Navigate to \FirstPart\Database\CreationScripts.

   There are two folders, SQL Server and ORACLE. Each folder contains database scripts to execute that will create the tables, views, indexes, and default data values.

2) Open the database configuration panel

   **SQLServer:** Management Console.
   - Log into the database with Administrator rights
   - Create a new database
   - Run the SQL scripts to create the appropriate values.

   **ORACLE:** SQLPlus or ORACLE Management Console
   - Follow the steps outlined earlier in this document in configuring the database prior to ORACLE installation. (See section 4.4.3 Brainware Distiller ORACLE Checklist)
   - Log into the database with user account where the tables will be located.
   - Run the database script to create the appropriate values.

3) Navigate to \FirstPart\Database\UpdateScripts

   Again, you will find folders for the SQL and the Oracle scripts.

4) Edit the Update Database script:

   - in Oracle script: TargetDBSchemaName
   - in MS SQL script: TargetDatabaseName

   **Note:** If you refrain from executing the steps outlined above, an error message will turn up on running of the Update Scripts.

5) Run the Update Database script.

6) Check that the database tables have been created correctly and no errors were reported on execution of the database scripts.

7) There are several configuration components that require modification. Navigate to the Brainware installation folder. By default this is located in Program Files\Brainware.

8) Navigate to the Brainware Distiller Web Server folder and open the Web.config file in Notepad.

9) Search for the connection string in the file.

    <connectionStrings></connectionStrings>

10) Modify the connection string to connect to the database.
**SQL Server Example**

```xml
<connectionStrings>
  <add name="Entities" connectionString="metadata=res://*/Entity.Entities.csdl|res://*/Entity.Entities.ssdl|res://*/Entity.Entities.msl;provider=System.Data.SqlClient;provider connection string="Data Source=DBINSTANCE\SQLEXPRESS;Initial Catalog=SQLServerDatabaseCatalog;Integrated Security=false;User ID=Brainware;Password=Brainware;MultipleActiveResultSets=True" providerName="System.Data.EntityClient" />
</connectionStrings>
```

**ORACLE Example**

```xml
<connectionStrings>
  <add name="Entities" connectionString="metadata=res://*/Entity.ORAEntities.csdl|res://*/Entity.ORAEntities.ssdl|res://*/Entity.ORAEntities.msl;provider=EFOracleProvider;Provider Connection String='Data Source=OracleServerName;User Id=Brainware;Password=Brainware" providerName="System.Data.EntityClient" />
</connectionStrings>
```

11) Navigate to the Brainware Distiller\bin folder.

12) There are 6 other configuration files which require changing as with the web.config.

    These are DstDsr.exe.config, DstHost.exe.config, DstSlm.exe.config, Brainware.System.Project.config, DstVer.exe.config, and DstWkBrw.exe.config. Open each one in Notepad to make the appropriate changes below.

13) Search for the connection string in the file.

    ```xml
    <connectionStrings/></connectionStrings>
    ```

    Modify the connection string to connect to the database. (Refer to Step 10 for examples)

14) For ORACLE installation, it is required to make one more addition to the .NET installation for the ORACLE connection string above to work.

    - Navigate to the Windows folder using Windows Explorer
    - Navigate to WINDOWS\Microsoft.NET\Framework\v2.0.50727\CONFIG
    - Open the machine.config file for editing and location the DbProviderFactories tag.
    - Add the lines below and do not delete any existing data.

    ```xml
    <system.data>
      <DbProviderFactories>
        <add name="EF Oracle Data Provider" invariant="EFOracleProvider" description="EF Provider for Oracle testing" type="EFOracleProvider.EFOracleProviderFactory, EFOracleProvider, Version=1.0.0.0, Culture=neutral, PublicKeyToken=def642f226e0e59b"/>
      </DbProviderFactories>
    </system.data>
    ```

5.3 Configuring the Brainware Distiller database (post install)

After the installation of Brainware Distiller with Database there are additional configuration steps that are required.

1. Check the project file names. The project file name will be used to display the available project lists in Web Verifier.

2. Review the list of users in the projects.
- All usernames and passwords must be consistent throughout all project files.
- Each user must have their own username and password – user IDs cannot be shared.

3. Export the users from the project file into the Brainware Distiller database. This will now make users available to access projects via the Web Verifier.

4. Log into the User table (known in ORACLE as USER_) and for each user, add a Forename and Surname into the Brainware Distiller database.

5. Create a Runtime Server instance for the project, or import existing Runtime Server settings, and configure again the Brainware Distiller database (creating a job and linking to the Brainware Distiller database).

You are now ready to use Brainware Distiller with Brainware Distiller database.

**See Also:**

For information on how to configure a project for a Brainware Distiller instance with Brainware Distiller database, or to migrate file system batches to the Brainware Distiller database, see the Brainware Distiller Runtime Server User’s Guide.

### 5.4 Cedar Workflow History Wrapper Component

In order to achieve better compatibility of Visual Studio (VS) 6, Brainware Distiller 5.4 SP1 introduces an intermediate wrapper component for Workflow History related operations.

The component *Cedar Workflow History Wrapper* (CdrWH.dll) has to be installed and registered in `\Brainware\Components\Cedar` directory.

The component is a COM component created with VS 2008 (V9) C++ and wraps the currently available base component for Workflow History operations, which is the Cedar Database Access component (CdrDB.dll).

To access the Workflow History functionality, the CdrWH.dll should be used instead of the CdrDB.dll.

### 5.5 Installing Brainware Distiller in a Workgroup Configuration

A Windows Workgroup, also referred to as Peer-to-Peer networking, is a network implementation of Windows-based operating systems (clients and servers) in which there is no central security authority (domain controller) responsible for user authentication or a central repository (such as Active Directory) for locating network resources.

In such a network, each machine is responsible for securing its resources, and users needing access to a resource located on a machine must have an account defined on that machine. Windows Workgroup networking should only be used when you want to set up communication between a limited number of computers (less than 10) and the machines are not members of a Windows domain.

For an implementation of Brainware Distiller in corporate network environments that are standardized on network operating systems (servers) other than Windows – Novell Netware – a Windows Workgroup setup may be the only choice. To install Brainware Distiller in Windows Workgroup, perform the following steps (you must be logged on as an Administrator):

1) Create a user with the same name on each Brainware Distiller machine. Brainware recommends Brainware Distiller RTSsvc as the user name. (This does not apply to machines that will be used only as a Designer or Verifier workstation.)

2) Add the above user to the local Administrators group on each Brainware Distiller server.
3) Install Brainware Distiller on each machine by following the steps in Section 5.1 Software Installation.

4) Configure and start the Runtime Service Manager by performing the steps in Section 8.2 Configuring the Runtime Service Manager on each machine, with the following exception: Wherever a domain user is requested, add the user created in step 1 above.

5) Configure the RTS Remote Administration MMC snap-in by performing the steps in Section 8.3 Configuring the RTS RemoteAdmin MMC Snap-in on each machine.

6) Configure project settings on each machine and test the instance created in Step 5 above. You should (at a minimum) test the OCR, Classification, and Extraction workflow steps. For more information on how to configure project settings for a Brainware Distiller RTS instance, see the Brainware Distiller Runtime Server User's Guide.

7) Once you have successfully tested each machine, test remote communication by adding a remote machine to the local MMC snap-in of one your servers. You can accomplish this by performing a subset of the steps (Steps 4 through 7) in Section 8.3 Configuring the RTS RemoteAdmin MMC Snap-in.

8) You should be able to administer the RTS instances (start, stop, change batch states, etc.) of the remote machine from the MMC snap-in of the local machine on which it was added.

5.6 Installing Brainware Distiller in Standalone Mode

Brainware Distiller can be deployed in a standalone mode. However, this implementation method is intended for test and demonstration purposes only. It should NOT be used in a production environment. Deployment of Brainware Distiller in Standalone mode for production purposes would be deemed unsupported by Brainware.

In this setup, all Brainware Distiller components (applications, RTS, Remote Admin MMC snap-in, etc.) are installed and intended to be used on a single machine. Additionally, the integrated machine is not part of a Windows domain or is not intended to communicate with Brainware Distiller RTS instances running on other machine(s) in a network environment.

Using this setup, almost all of the configuration constraints (Windows domain, Users and Groups, etc.) can be ignored.

To install Brainware Distiller in a standalone mode:

1) Attach your supplied hardware key (serial or USB dongle) to the machine.

2) Install Brainware Distiller Version 5.4 SP1 by following the steps in Section 5.5 Installing Brainware Distiller in a Workgroup Configuration.

3) Replace the demo license file, zCroDemo.lic, located in the …\Brainware\Components\Cairo folder, with a valid license file corresponding to the serial number of your supplied hardware key. Brainware Distiller license file names are usually in the format *_xxxxxxx.lic: where * can be any number of alphanumeric characters and xxxxxxxx is an eight-digit number representing the serial number printed on the corresponding dongle.

4) Configure the RTS Remote Administration MMC snap-in by following the steps in Section 8.3 Configuring the RTS RemoteAdmin MMC Snap-in with one exception: In Step 6 of the procedure outlined, type LocalHost instead of the server name.

5) Configure project settings and test the instance created in step 4 above. You should (at a minimum) test the OCR, Classification, and Extraction workflow steps. For more information on how to configure project settings for a Brainware Distiller RTS instance, see the Brainware Distiller Runtime Server User's Guide.
5.7 Checking the Installation

The installation was successful if Brainware Distiller runs without errors.

To check for the correct installation of components:

1) Open the installation directory.
2) Open `\Components\Tools`.
3) Run SCBLibVersion.exe.
4) From the menu, select View>Components General Info. This displays a list of installed components:
5) Check the list for
   - Completeness of components
   - Homogeneity of build numbers
   - Installation paths
6) All components Cro*.dll, Cdr*.dll and Bwe*.dll should have been registered automatically during the installation. If some of them seem to be missing, try to register them manually via the RegCro.bat, RegCdr.bat and BweReg.bat Windows batch files available in `\Components\Cairo`, `\Components\Cedar` and the corresponding `\Components\Bwe` directories.

If the automatic registration does not work, try to register manually using the program regsvr32.exe from the Windows system directory.

If this does not help, create a copy of the components list using the command File>Save to file in the Brainware Component Version Info dialog box. Submit an error report, the components list, and the log files located in the `\Brainware\Brainware Distiller\Logs` folder to Brainware Customer Support.

5.8 Migrating Existing Project Files to Version 5.4 SP1

After you remove the earlier version of Brainware Distiller and install Version 5.4 SP1, project files designed in the earlier version must be converted to Version 5.4 SP1 formats before they can be used in the new version.

The conversion process is fully automated and is done by Brainware Distiller Designer. To convert Brainware Distiller Version 3.0, 4.x or 5.3 project files to Version 5.4 SP1, do the following:

1) Launch Brainware Distiller Designer.
2) On the Load Project dialog box, browse to the project file location and double click on the project file that you want to convert. Login to the project using Administrator for User ID with the corresponding password.
3) Click OK to launch the automatic project conversion process. The conversion takes from a few seconds to a few minutes, depending on the size of the project.
4) Once the conversion is completed, click Learn (Light bulb) to relearn the project.
5) Save the project. The project is ready for use in Brainware Distiller Version 5.4 SP1.

**Very Important!**

*Please note that a project and Learnset backup should always be taken.*

See Also
For information on how to configure a project for a Brainware Distiller database, see the Brainware Distiller Designer User’s Guide.

5.9 Removing Brainware Distiller Version 5.4 SP1

Brainware Distiller can be uninstalled by using the Windows Control Panel’s Add/Remove functionality. It is important to stop all running services using the Task Manager before uninstalling the application. To remove previous versions of Brainware Distiller:

1) Click Start>Settings>Control Panel.
2) Launch the Add/Remove Program wizard.
3) On the Currently Installed Programs list, select Brainware Distiller V5.4 SP1.
4) Click Remove.
5) Follow the on-screen instructions. (See Figure 5-20 below).

Figure 5-20: Removing a Brainware Distiller installation

6) After un-installation, reboot your computer.

5.10 Repairing a Brainware Distiller Version 5.4 SP1 Installation

The Brainware Distiller installer may be used to repair a copy of Brainware Distiller that has stopped working properly. Factors that could cause an installation to malfunction include:

- Accidental deletion of application files
- Missing registry entries
- Corrupted application files
- Malicious attacks on a machine housing Brainware Distiller

To repair Brainware Distiller:

1) Select Start>Settings>Control Panel.
2) Select Add/Remove Program.
3) In the Currently Installed Programs list on the Add/Remove Programs dialog box, select Brainware Distiller v5.4 SP1.
4) Click Change.
5) On the Setup dialog box, select Repair then click Next. (See Figure 5-21 below) This will reinstall all program components which were installed by the previous setup.
6) Click *Finish* when setup is completed.

### 5.11 Adding or Removing Version 5.4 SP1 Components

Brainware Distiller is a product suite consisting of the following applications:

- Brainware Distiller Runtime Server
- Brainware Distiller Designer
- Brainware Distiller Verifier
- Brainware Distiller Web Verifier

The Brainware Distiller deployment utility, Setup.exe, uses a modular approach that enables you to add or remove applications from a machine.

To modify an existing Brainware Distiller installation:

1) Select *Start>Settings>Control Panel*.
2) Select *Add/Remove Program*.
3) In the *Currently Installed Programs* list, select Brainware Distiller V 5.4 SP1.
4) Click *Change*.
5) On the *Setup* dialog box, select *Modify* and click *Next*. (See Figure 5-22 below)
6) In the Select Components dialog box, select or clear the desired components.

7) Click Next. Setup adds (if checked) or removes (if unchecked) the components.

8) Click Finish when setup completes.

5.12 Installing Brainware Distiller Service Packs / Service Updates

Interim updates, minor enhancements, and defect corrections for Brainware Distiller are typically released as a service pack. Service Packs for Brainware Distiller are self-extracting executables. Brainware distributes them in a number of ways, including e-mail and product CDs.

A Release Notes document detailing the product issues addressed and deployment instructions specific to that service pack accompanies each Service Pack release.

Generally, you can install the Brainware Distiller service packs as follows:

1) On the Windows Desktop, click Start → Run.

2) Browse to the location of the Service Pack executable.

3) Double click on the executable.

4) Follow the on-screen instructions.

Note: After installation of a service pack, launch the Register Web Server.bat in the Brainware Distiller Web Server\Bin folder and run the CdrReg.bat in the Brainware Distiller\Components\Cedar folder in order to register all of the new components. Only then, you will be able to open batches in Web Verifier.
The following steps are to be followed:

- Backup your project data before application of Service Updates or patches to your system.
- Backup the configuration of your IIS. To do this, open the IIS Manager under Control Panel → Administration Tools → Internet Information Services, right click on your local machine, and then select All Tasks and Backup/Restore Configuration.
- Before installation of a new patch, all RTS instances have to be stopped and all of the Brainware Distiller applications have to be exited.
- After installation of a Web Verifier patch or Service Update, restart IIS. To do this, open the IIS Manager, right click on your local machine, go to All Tasks, and then click on Restart IIS.
- Perform standard sanity testing procedures.

### 5.12.1. Current patch level

If you want to check for the current version of the combined patch you are using, do the following:

2. Check the highest file version of the “Cdr*.dll” in \Components\Cedar and “Dst*.dll/exe in \Brainware Distiller\bin.

The highest of the version number is the installed patch.

### 5.13 Password Encryption for Database Connection Strings in Core Distiller Config Files

The application architecture of Brainware Distiller makes it very important to be able to hide sensitive security information, such as DB access password, stored in Brainware Distiller or custom project configuration files.

Password encryption is optional and former configuration files with unencrypted passwords will still work with no issues.

Below are the steps to encrypt the database connection password for the core Brainware Distiller *.config files:

1. Open one of the Brainware Distiller config files you use, for example .\Application\bin\DstDsr.exe.config in a text editor.
2. Locate the connection string and the password part of the string, example:

   ```xml
   <add name="Entities"
    <connectionStrings>
    </connectionStrings>
   ```

3. Modify the password, replacing it with any amount of star signs, example:

   ```xml
   <add name="Entities"
   ```
Security=false;User ID=alexey; Password=********;MultipleActiveResultSets=True"
providerName="System.Data.EntityClient" />

</connectionStrings>

Note: the number of * is not important.

4. Run the .Brainware\Brainware Distiller\bin\DstCrypt.exe tool with the following arguments:
   a. DstCrypt.exe /text "MyPassword" >> my_encrypted_password.txt
   b. You could add the line above to a new .bat file created in Brainware\Brainware Distiller\bin\ directory and double click on it - this should produce a new file with the name "my_encrypted_password.txt" in the same directory where the executable is located.

5. Open the resulting text file:
   a. It will contain a text like in the example below. Copy its red part that represents the encrypted password:

   Text MyPassword encoded to
   Y652CeXVdMtdnN2p8nKUgv2F7M7uu52o3V7wKh575A5z6Gcox/KEm60
   16A9f1X+85mi0Qg7nCq0hRzAb1ChzmEJbCkaMplo0cvtP+8heJVM1BpD+QkflIithUXINhWaCM=

6. Locate the "appSettings" section of your DstDsr.exe.config file and add the new "EncrPwd" key to this section, assigning the red encrypted sequence above to the value of the key. Example:

   <appSettings>
   <add key="EncrPwd"
   Y652CeXVdMtdnN2p8nKUgv2F7M7uu52o3V7wKh575A5z6Gcox/KEm60
   16A9f1X+85mi0Qg7nCq0hRzAb1ChzmEJbCkaMplo0cvtP+8heJVM1BpD+QkflIithUXINhWaCM="
   </appSettings>

7. Save your DstDsr.exe.config file.

8. When required, apply steps 1-7 to the other core Distiller configuration files, that represent different Distiller applications. These are:
   a. For Runtime Server application: .\Application\bin\DstHost.exe.config
   b. For Learnset Manager tool: .\Application\bin\DstSlm.exe.config
   c. For Designer application: .\Application\bin\DstDsr.exe.config
   d. For Thick Verifier application: .\Application\bin\DstVer.exe.config
   e. For supervised learning nomination feature of Web Verifier application: .\Application\bin\Brainware.System.Project.exe.config
   f. For Web Verifier application: .\Application Web Server\web.config

Note: corrupted or incorrect encryption key or an incorrect password in the web.config file will entail the following error message when trying to open the Web Verifier application:

![Error message](image)

Figure 5-23: Error message associated with incorrect encryption key/password
5.14 INI File Encryption

Brainware Distiller allows the user to encrypt a password within the open text INI file. For example, for database connections (Reporting, PO Lookup), SAP connections (Export), etc. RSA encryption is used which provides a public key and a private key.

Public Key: provides customer or PS integrated, for user who wants to encrypt text in INI file. It is distributed to PS teams and customer service for generating an encrypted passwords.

Example:

```
<RSAKeyValue>
  <Modulus>vJ+W7SuXuvOrWVoy4tPrbfLCuoHe1o750cpTuEzLPk6iz6baYAdoPVqLpaOEK+XMM52G5z+69
  61vuQdGwt+01AgPiTXCa6rrraeCaad04m18wmpw00kU2EFC2pTTYCQPFFl1gokwomF6VDSD9d10U340IT0ctQY1b51M
  4mQ2=</Modulus>
</Exponent>
</RSAKeyValue>
```

Private Key: held by project owner/developer only.

Example:

```
<RSAKeyValue>
  <Modulus>vJ+W7SuXuvOrWVoy4tPrbfLCuoHe1o750cpTuEzLPk6iz6baYAdoPVqLpaOEK+XMM52G5z+69
  61vuQdGwt+01AgPiTXCa6rrraeCaad04m18wmpw00kU2EFC2pTTYCQPFFl1gokwomF6VDSD9d10U340IT0ctQY1b51M
  4mQ2=</Modulus>
  <Exponent>AQAB</Exponent>
  <P>8SRHEvT5Bn2paRHSR9yYCB7NYE9.PbeHzugW6iWaOLNYJsr
  hhUeCEpw1LIPwGq10KzMeGqG0+Brt4nBmNaHqQ=</P>
  <Q>yD719fjB/MJNYv3LcEzY286Q+Xv07j167HvHSq1B1KYNyCn9
  xf9d8kibUOQnB2/4F0T6ePe7OJ2KFRXXnQoQ==</Q>
</RSAKeyValue>
```

Below is the new connection parameter:

```
SQL_VL_01_ConnectionString=Provider=SQLOLEDB.1;Persist Security Info=True;User ID=sa;Initial Catalog=MyData;Data Source=10.4.0.19
SQL_VL_01_ConnectionPassword=MyEncryptedPassword
```

5.14.1. INI File Encryption for Project Developer

The idea of coding is to locate the code that calls Database Connection from the INI file, so that you can read the new line in the INI file with an encrypted line text. The password then can be decrypted by using a Private Key. At last, you append the password to the end of the Connection String in the INI file.

As a project developer, you can select the CdrCrypt ScriptModule in the Reference section of Project File Script Page.

Figure 5-24: Script Module References

**Note:** Additional security can be provided by Encrypting Script Page.

Example script of the encrypted password:

```
Dim theCedarCryptographyHelper As New CdrCrypt.RSACodecInt
Dim strEncryptedPassword As String
Dim strOpenPassword As String
Dim strPrivateKey As String
strPrivateKey = "<RSAKeyValue">
```

Brainware Distiller Page 44 of 131
5.14.2. INI File Encryption for Integrator

As an integrator, you simply need to add the encrypted customer password, and encrypt the password similarly to Config files.

Run the following command in the Brainware\Brainware Distiller\bin folder:

```
DSTCrypt.exe /text "MyPassword" /key <RSAKeyValue><Modulus>vJ+W7SuXuvOrWVoy4tFrbfLCueHE1o750cpTuZlPK6ix6bNAodPVgLsOEK+XMMxZG5z+6961yuqyDGU+01ag1PifKca6rAaeCaD04H8Mnwpw00UZefCzT1YCYQPF1gokwom6V0DBSk94D03107gctQY1b5iM4MqT0</Modulus><Exponent>AQAB</Exponent><P>8SRHEvT5Bn2paRHSR9yCQb7WGYE9PbeNuzqW61Ma0LNYJrSRhUHeCepx1PLQWoq10RmMzG0+Br4nuBdmNHQ==</P><Q>yD719fjB/JMYWaV3LCeZyY286Q+xVvo7416TtvhKkgBG11YGCn9xf9DHXb1UQNgB2/4F0276enFYOD323FvRHaHoQ==</Q><DP>nRDFsn7nwRmSgfrW8mInyk55Q31F03SE12+x3A04252ZwKStwDze/c12vR3XVg7irvUDNB1z0nDKik1Sw5Q==</DP><DQ>B3xieGm0v0Vsa05/22kPp3A3ubAADjy6FC5aS07tqC+vXMfd0D5f1J1eFA+iP1pIyZyvyt10tCHABA7Y085QQ==</DQ><InverseQ>4S1xqlXK9frlCkGCh8vOPvG61z1FCq038fryDE87/gUjilHRvJZaciCacgYyf3RMRKrXqBx8i99k7dEDNUyc8wQ==</InverseQ><D>KAL6cwkCQKpsbuvKFRN5LzFMqFqV2JpB5kI/p1U+0GWAs6Q4w4wPgyr+5303na042faPcxtL5SKjy7X21VMUCavyvbOSxBtc1cSHjP4ueQPA7u+gri1JaDYRhiAVoqNCFJEX6+McV3J+i/X+m2DCdUbCuA0Nn01d4UV0aMejYDBE</D>" RSAKeyValue>"
```

The `my_encrypted_custom_password.txt` will now contain the encrypted text string for the password.

And then, add the encrypted password to the ConnectionPassword INI tag.

```
SQL_VL_01_ConnectionPassword=puejB5SQwFywe6MROcHclGly7q8XsA9gU2jhN6Jo1hYdKxt1s7v1M2JbYmS9J3Ayxu1p70CqRgnSAmg6lF1P2KxtRmf5SSXwCDMwYygfB5eS3Iaq111Fh7t1CVfr32eWttK+3umahfexpESUQ7MzF36eunV4V386F9Xw=
```

5.15 Silent Installations

A Silent Install mode is provided for situations where the same configuration of Brainware Distiller is to be installed on several machines, for example, Verifier workstations. The use of a configuration file removes the necessity to go through the installation dialog on each machine.

5.15.1. Silent Install.ini

The configuration settings for the silent installation are read from the “Silent Install.ini” file in the Brainware Distiller installation directory. The directory contains an example file which must be edited before performing a silent installation.

The file contains seven sections – General, Applications, OCR Engines, Additional, AutoServiceUpdate, Database Configuration, and DB Credentials.

It’s allowed to delete single entries or complete sections.
However, it's not allowed to use options without the section name. If any information is deleted from the "Silent Install.ini" file, the Setup uses the DEFAULT values as described.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>[General]</strong></td>
<td></td>
</tr>
<tr>
<td>Path =</td>
<td>Indicates where the application should be installed. The pathname should not have a final backslash. Example: Path = C:\Program Files\your company name.</td>
</tr>
<tr>
<td>MoveComponentsIfRequired =</td>
<td>If an older version of the application is installed, this indicates whether to use the existing component folder or whether to move the old components into the new directory prior to installation.</td>
</tr>
<tr>
<td></td>
<td>0: Use existing component folder.</td>
</tr>
<tr>
<td></td>
<td>1: Move components to the new path.</td>
</tr>
<tr>
<td>CreateDeskTopIcons =</td>
<td>0: Don’t create desktop shortcuts.</td>
</tr>
<tr>
<td></td>
<td>1: Create desktop shortcuts.</td>
</tr>
<tr>
<td>InstallWibuKey =</td>
<td>0: Skip Wibukey driver installation.</td>
</tr>
<tr>
<td></td>
<td>1: Install Wibukey drivers.</td>
</tr>
<tr>
<td>StopIfDotNetIsNotFound = #</td>
<td>0: If .Net Framework 3.5 SP1 is not found on the system the installation proceeds. The Features (WebVerifier, Database Connection...) will not be installed.</td>
</tr>
<tr>
<td></td>
<td>1 (DEFAULT): If .Net Framework 3.5 SP1 is not found on the system the installation will be aborted.</td>
</tr>
<tr>
<td><strong>[Applications]</strong></td>
<td></td>
</tr>
<tr>
<td>Designer =</td>
<td>0: Skip installation of the Designer application.</td>
</tr>
<tr>
<td></td>
<td>1: Install the Designer application.</td>
</tr>
<tr>
<td>Verifier =</td>
<td>0: Skip installation of the Verifier application.</td>
</tr>
<tr>
<td></td>
<td>1: Install the Verifier application.</td>
</tr>
<tr>
<td>Runtime Service =</td>
<td>0: Skip installation of the Runtime Server application.</td>
</tr>
<tr>
<td></td>
<td>1: Install the Runtime Server application.</td>
</tr>
<tr>
<td>Web Verifier=</td>
<td>0: To skip installation of WebVerifier application (Thin Client)</td>
</tr>
<tr>
<td></td>
<td>1 (DEFAULT): Install WebVerifier application (See also option StopIfDotNetIsNotFound)</td>
</tr>
<tr>
<td><strong>[OCR Engines]</strong></td>
<td></td>
</tr>
<tr>
<td>FineReader8.1 =</td>
<td>0: Skip installation of ABBYY FineReader 8.1.</td>
</tr>
</tbody>
</table>
### Name | Description
--- | ---
1: Install ABBYY FineReader 8.1. | 


Kadmos5 = 0: Skip installation of Kadmos 5 engine. 1: Install Kadmos 5 engine. | 

Recognita = 0: Skip installation of Recognita engine. 1: Install Recognita engine. | 


Cleqs = 0: Skip installation of Cleqs engine. 1: Install Cleqs engine. | 

[Additional] Additional files to install. | 

Demo Files = 0: Skip installation of the demo project files. 1: Install demo project files. | 

[AutoServiceUpdate] Defines the installation of automatic ServiceUpdate (will be skipped if ForDesigner and ForVerifier are skipped) | 

ForDesigner = 0 (DEFAULT): Skip definition of ServiceUpdate for Designer Application. 1: Defines Shortcut for Designer start with automatic ServiceUpdate | 

ForVerifier = # 0 (DEFAULT): Skip definition of ServiceUpdate for Verifier Application. 1: Defines Shortcut for Verifier start with automatic ServiceUpdate. | 

NetworkUpdateFolder = *** Path where automatic ServiceUpdate looks for Updates. (DEFAULT empty string) | 

[Database Configuration] Configures Existing DatabaseServer (See also option StopIfDotNetIsNotFound). | 

DBServerType = # 1: SQL Server database will be configured. 2: Oracle Server database will be configured. 3 (DEFAULT): No database will be configured. | 

If there is any wrong information for the following options DBServerType will be set to 3 | 

UseDBConfIniFile = *** Text file name that contains Database Connection String. If this option is empty, credentials will be taken from [DB Credentials] section. If there is neither a config file nor a [DB Credentials] section, DBServerType will be set to 3 (no database) internally. (DEFAULT empty string). | 

Table 5-2: Options for "silent install.ini"

An example "Silent Install.ini" INI-file is available in the root setup directory.

Example:

[General]
Path = C:\Programme\Document Processing Services
MoveComponentsIfRequired = 1
CreateDeskTopIcons = 1
InstallWibuKey = 1
StopIfDotNetIsNotFound = 1
[Applications]
Designer = 1
Verifier = 1
Runtime Service = 1
Web Verifier= 1
[OCR Engines]
FineReader8.1 = 1
5.15.2. Automated Distribution of Service Updates on Verifier Workstations

Silent Installation can also be used to install service packs and service updates automatically on Verifier workstations when updates become available in a pre-defined network folder by running a batch file with the following content:

Call "Silently Install Latest Service Update.bat"

Call "C:\Program Files\ [WL SCN]\ [WL PN]\DstVer.exe"

5.16 Preparing Internet Information Server (post install)

One of the preconditions for working with Brainware Distiller Web Verifier is the installation of the Internet Information Server. Windows 2003 Server works with IIS 6.0, Windows 2008 Server with IIS 7.0.

Perform the installation of the appropriate IIS application version. Please use the following links for more information:

- For Windows 2003 Server and IIS 6.0
  

- For Windows Server 2008 or Windows Server 2008 R2 and IIS 7.0/IIS 7.5
  
  http://learn.iis.net/page.aspx/29/installing-iis-7-on-windows-server-2008-or-windows-server-2008-r2/

5.16.1. Configuring IIS 6.0

The Internet Information Server is used for executing the Brainware Distiller Web-Verifier. The IIS configuration is presented below.
• Run IIS manager (Start -> Control Panel -> Administrative tools – Internet Information Services)

• Extend Web Sites.

• Right click on Default Web Site node, then choose New->Virtual Directory

Figure 5-25: IIS 6.0 manager

• In the dialog window click Next.

Figure 5-26: Virtual Directory Creation Wizard

• Type in the Alias you want to use to gain access to this Web virtual directory. Click Next.
Figure 5-27: Alias for the Web virtual directory

- Select the path to the directory with the installed Brainware Distiller Web Server and click Next.

Figure 5-28: Path for the Web Site Content Directory

- Set the permissions as shown in the screenshot below. Click Next.
• Press *Finish*.
• Right click on the Web Verifier node then select *Properties*.
• In the dialog window, open the *ASP.NET* tab.
• Check the ASP.net version. If it is not a v.2.0 – set it to v.2.0.
• Select the *Documents* tab. Remove all default content pages, and add Login.aspx to the list.
Click OK.

The Brainware Distiller Web Verifier application will be accessible by the address http://localhost/WebVerifier/login.aspx

5.16.2. Configuring IIS 7.0

Run IIS Server Manager (Start -> Administrative tools – Server Manager)
Extend the Roles directory.

Click **Add Roles**.

Select **Web Server**.
You will be asked to install other required features.

Click *Add Required Features*.

Now you will be able to select the Server Roles.
Click Next.

Continue by clicking Next

Select the Role Services as follows:
If you try to install ASP.NET, you will be asked to add additional services and features.

Add required role services and features by selecting on the appropriate buttons.

Now you will be able to complete the selection.
• Confirm by clicking Next.

• Now click Confirmation.

• Click Install to install the selected roles, role services, and features.
• Check the Result overview and finish by clicking on Close.

• Repeat the steps for the installation of the Application Server.
After installation of the required additional roles and features, the Result view will be the following:

Check the Roles view again.
• Now run IIS manager (Start -> Administrative tools – Internet Information Services (IIS) Manager)

• Right click Default Web Site.
• Select the **Add Application** menu item.

• In the dialog window, enter the Alias you want to use to gain access to this Web virtual directory. Set the **Physical path** to the directory with the installed Brainware Distiller Web Server and then click **OK**.

![Add Application dialog](image)

**Figure 5-49: Settings for Alias and the physical path**

• Double click the **Default Document** icon.
Click Add.

Add Login.aspx to the list.
The Brainware Distiller Web Verifier application will be accessible by the address [http://localhost/WebVerifier/login.aspx](http://localhost/WebVerifier/login.aspx).

### 5.16.3. Windows 2008 and above

Disable DEP with following command:

* `bcdedit.exe /set {current} nx AlwaysOff`

Note: The server must be rebooted after this command has been applied.

### 5.16.4. Windows 2008 64bit R2

The following steps are required in order to configure IIS 7.5 for your operating system:

1. Create an application pool or change defaultAppPool with the following advanced properties:
   * Enable 32-bit applications = True
   * Managed pipeline mode = Integrated
   * Identity is set to NetworkService
2. Assign the Web Verifier application to this application pool so that the application can run under 32-bit mode.
3. Disable DEP with following command:
   * `bcdedit.exe /set {current} nx AlwaysOff`

   *Note: The server must be rebooted after this command has been applied.*

### 5.16.5. Enabling HTTP Compression on your Windows 2003 Server

To more efficiently use available bandwidth, enable IIS HTTP compression. HTTP compression provides faster transmission time between compression-enabled browsers and IIS. HTTP compression allows faster page serving to clients and lower server costs due to lowered bandwidth.

- Open up IIS and right click on *Web Sites* node, and go to *Properties*.
- Go to *Service* tab. (See figure below)
**Figure 5-53: The Web Sites Properties dialog box**

- Set up values as shown in figure above.

**Compress application files:** Check this to compress application files. It works only if you have **Compress static files** checked.

**Compress static files:** Check this to compress static files. Selecting this option will activate the Temporary directory text box.

**Temporary directory:** You can leave this at the default, which is `%windir%\IIS Temporary Compressed Files`, or set it to a custom folder. This is where temporary compressed static files will be stored.

**Maximum temporary directory size:** This option enables you to set the maximum size of the temporary directory. Once the size limit is reached, newly added files will replace the oldest files.

- Next, go to **Web Service Extensions**. Right click on the right panel, and then click **Add a new Web service extension**. You can enter any name for the extension, but HTTP Compression is recommended.
5.16.6. IIS 6.0 Metabase Configuration - MetaBase.xml

- Open Windows Explorer and go to C:\Windows\System32\inetsrv.
- Find MetaBase.xml and make a backup copy.
- Now open up MetaBase.xml in a text editor. Find the <IlsCompressionScheme/> section. Be careful, there are two sections here: one for deflate and one for gzip. Select the section for gzip. (See Figure 5-55) The Location attribute of this element will have the following value: Location ="/LM/W3SVC/Filters/Compression/gzip". Look for the HcScriptFileExtensions section. As default, it should contain: asp, dll, and exe. This is where you add any extensions you want to be compressed for dynamic files. For instance, you can add the extension aspx.

Note: Use a list format for the file extensions as in the sample below using a new line for each extension and indenting them using tabs. For Web-Verifier this section should look as follows:
Save this document by opening IIS and right click on the top node, *Internet Information Services*, and then check *Enable Direct Metabase Edit*.

The final step is to exit IIS and to restart by right clicking *Internet Information Services* node, and then click *All Tasks, Restart IIS*.
Chapter 6 Configuring Application

6.1 Configuring Application

There are some main configuration parameters to be accounted for. See Appendix A for more information.

6.1.1. Configuring Brainware Distiller Database connection string

- Open the application configuration file (Brainware Distiller Web Server\web.config)
- Find the following string:

  ```
  <connectionStrings>
  </connectionStrings>
  ```

- Modify the connection string in accordance with your database settings.
- Replace the connection string within the Brainware.System.Project.exe config file by the one configured within the web.config file.

Note: These two connection string entries must be identical in order to assure the availability of all Web Verifier functionalities associated with the Knowledge base.

6.1.2. Setting path to license file

- Open the application configuration file (Brainware\Brainware Distiller Web Server\web.config)
- Find the following string:

  ```
  <project.controller>
  <project licensePath="{app_root}\License\Runtime.lic" ...
  </project.controller>
  ```

- Modify the licensePath value in accordance with the location of your license file.

6.1.3. Enable HTTP compression for IIS 6.0 and IIS 7.0

In order to enhance your application performance and to save server costs, it is recommended you enable HTTP compression in the context of the Internet Information Services.

Please use the following links for detailed information.

For IIS 6.0:


For IIS 7.0:


6.2 Server Security Configuration

6.2.1. Registering COM components

After applying a patch, locate and run the 'Register Web Server.bat' as administrator. It is located in the Brainware Distiller Web Server\bin folder. For registering this component:

...
• Right click on the Register Web Server.bat file.
• Select Open from the context menu.

6.2.1.1. Preparing the User Context

It is necessary for the user of the user context in which the Web Verifier is running in IIS to have the proper rights to access the SQL Server database. By default, the Web Verifier runs under the NETWORK SERVICE user context, hence the same should be allowed to access the database.

If you select Windows Authentication during the installation of Brainware Distiller, you will need to add the domain username to the SQL Server 2008 DB additionally to the NT AUTHORITY\NETWORK SERVICE.

Steps to add Network Services to SQL server:

1. Open Microsoft SQL Server Management Studio.
2. Expand the local computer name, select Security → Logins.
3. Right click Logins, select New Login.
4. On Login Properties, under General, click Search. Enter NETWORK SERVICE and then click Check Names. Click OK.
5. In Login Properties window, under General, select Windows Authentication.
6. Under Server Roles, select serveradmin and sysadmin (public is selected by default). Click OK.
7. Repeat steps 2 – 4 to add the domain username. Click OK to confirm.
8. Select sysadmin (public is selected by default) for Server Roles. Click OK.
9. The NT AUTHORITY \NETWORK SERVICE has been added to SQL server.

Figure 6-2: Login list

After adding Network Service and domain username to SQL server, make sure that the IIS is running under NT AUTHORITY \NETWORK SERVICE by opening the IIS Manager.

To open IIS Manager from Start menu:
1. Click Start, and then select Control Panel.
2. Select Administrative Tools, and then click Internet Information Services (IIS) Manager.
3. In the Connections panel, expand the server node and click Application Pools.
4. On Application Pools, select the application pool which you want to specify an identity, and then click Advanced Settings in the Actions panel.

Figure 6-3: Application pools list

5. For the identity property, the built-in account should be NetworkService.

Figure 6-4: Identity.
6. If it does not contain NetworkService, click Set… to open the Application Pool Identity dialog box.

![Application Pool Identity dialog box](image)

**Figure 6-5: Application Pool Identity dialog box.**

7. Select the Built-in account option and select NetworkService account from the list.

### 6.2.2. Setting Permissions for Brainware projects execution

All Brainware projects are located in a filesystem folder. The Web Verifier sources this path from the Brainware Distiller Database. Brainware projects are loaded by the “Brainware.System.Project.exe” process. This process cannot load the projects until it has the appropriate permissions for the projects folder. In this case, it is necessary to grant permission to the “Network Service” Windows user for this folder by performing the following steps:

- Select the projects folder.
- Right click on the folder and select Properties.
- In the dialog window, select the Security tab.
- Add the Network service user to the list.

### 6.2.3. Encrypting sections with aspnet_regiis tool

If you want to protect the data stored in the configuration file perform the following steps:

**Pre-configuring:**

- Find the “Brainware.System.AppConfiguration.dll” file in the Brainware Distiller\bin\ directory.
- Register this assembly in the GAC using the `gacutil -I Brainware.System.AppConfiguration.dll` command.

**Encryption of the web.config file:**
• Use the `aspnet_regiis` command-line tool. This tool is located at:
  
  `C:\WINDOWS\Microsoft.NET\Framework\v2.0.50727\aspnet_regiis.exe`

• For encrypting a particular section of the configuration file, you can use the `-pe` option when executing the aspnet_regiis tool.

For example, for encryption of the connectionStrings section use:

```bash
aspnet_regiis -pe connectionStrings -app/MyApp
```

*Note: The “-app” option is used to specify the application’s virtual path.*

**Decryption of the web.config file:**

• For decryption of a configuration section, use the following command: `aspnet_regiis -pd connectionStrings -app/MyApp`

### 6.3 Client Security Configuration

This section describes security configuration for the client side.

• Open your Internet Browser. Select Tools->Internet Options, and then select the Security tab. Click Custom Level…

![Figure 6-6: Internet Browser – Security tab](image)

• Check for the configuration settings (See the screenshots below)

  ✓ ActiveX controls and plug-ins:
  
  • *Binary and script behaviors* setting should be *Enable*.
  
  • *Run ActiveX controls and plug-ins* setting should be *Enable*. 
Figure 6-7: Custom level configuration settings – ActiveX controls and plug-ins

✓ Scripting
  - Active scripting setting should be **Enable**.
  - Allow status bar updates via script setting should be **Enable**.

**Note:** Only if allowing status bar updating via script is enabled, will the information on batches, documents, current filters and page number be displayed.
6.4 Configuring Windows Authentication for Web Verifier

The Web Verifier application allows you to login with your Windows user account. In this case, the password that is shared with Windows will be used to login into Web Verifier.

To use this option, you first need to configure the server.

**Note:** Only Windows Authentication access will be possible after this option is configured. However, when logged in to Web Verifier via Windows Authentication, it will be possible to use the re-login menu option to login e.g. as an administrator in order to perform certain administrative tasks.

Prerequisites which apply to both, IIS 6 and IIS 7

- Before starting to configure IIS, make sure that the Web Verifier application is working properly using an existing project user account.
- Back up the web.config file.

6.4.1. For IIS 7

To configure Windows Authentication access to Web Verifier with IIS 7:

1. Open “Authentication” application settings in IIS group.
Figure 6-9: Entering Authentication application settings

2. Enable “Windows Authentication” and disable all other authentication methods.

Figure 6-10: Enabling/Disabling authentication methods

3. Close all of the running browser sessions prior to access the Web Verifier application.

4. Add the Windows user to the database. Please refer to the Designer User Guide for information on how to do this.

Note: In IIS 7, Error Pages will be configured automatically.

6.4.2. For IIS 6

To configure Windows Authentication to Web Verifier with IIS6:

1. Open the WVC application properties.

2. Go to Directory Security tab, Authentication and access control section and press the Edit button.
3. In the **Authentication methods** dialog, enable **Integrated Windows Authentication** and disable all other authentication methods.
4. In order to enable custom error page for “Not Authorized” status, it is needed to configure IIS to redirect to `<Web Verifier Installation Directory>/ErrorPages/401.htm` when 401.x error is received:
   - Select WVC application properties.
   - Go to Custom Errors tab.
   - Select each of the 401; x error code properties one after another.
   - When one of the properties selected, press the Edit button.
   - In the Edit Custom Error Properties dialog, select File for Message Type.
   - Enter path to `<Web Verifier Installation Directory>/ErrorPages/401.htm`
5. In order to enable custom error page for “Not Found” status it is needed to configure IIS to redirect to `<Web Verifier Installation Directory>/ErrorPages/404.htm` when 404.x error is received.
   - Select WVC application properties.
   - Go to Custom Errors tab.
   - Change all 404;x error code properties to point to file `<Web Verifier Installation Directory>/ErrorPages/404.htm`
6. In order to “Not Found” page being shown for invalid .aspx addresses (e.g. Batch.aspx – does not exist but would be a valid page name from IIS point of view) configure IIS the following way:
   - Go to properties of Default Web site.
   - Select the **Home Directory** tab.
   - Press the **Configuration** button.
   - Select the **Mappings** tab.
   - Select the .aspx extension option from the list.
   - Press the **Edit** button.
   - Check the **Verify that file exists** checkbox.
7. After submitting, the following "Inheritance Overrides" dialog will be present.
   - Choose WVC site to apply this setting.

![Inheritance Overrides](image)

Figure 6-17: Inheritance Overrides

Note: The "Not found" error page configuration is also used for standard authentication mode.

8. The web.config file needs to be modified. See Changes to Web.config File section below.

9. Close all of the running browser sessions prior to access the Web Verifier application.

10. Add the Windows user to the database. Please refer to the Designer User Guide for information on how to do this.
6.4.3. Changes to Web.config File

It is highly recommended to have two versions of the web.config file – one for standard authentication and one for Windows Authentication. This will simplify switching between modes.

The following list shows required steps to convert standard web.config to a web.config with Windows Authentication enabled.

The steps generally apply to both, IIS 6 and IIS 7. Exceptions are mentioned appropriately.

1. Change `<authentication>` section (located in the `<configuration><system.web>`) to the following:
   `<authentication mode="Windows">`

2. Remove the following line:
   `<forms loginUrl="Login.aspx" defaultUrl="BatchView.aspx" />`
   This is a child of the `<authentication>` section, and is only needed for standard authentication.

3. Change `<authorization>` section (located in the `<configuration><system.web>`) from ‘deny’ to ‘allow’:
   `<authorization>
   <allow users="?"/>
   </authorization>`

4. Add `enableSessionState` attribute to `<pages>` section (located in the `<configuration><system.web>`):
   `<pages enableSessionState="true">`

5. Remove all `<location>` sections (located in the `<configuration>` right before `<appSettings>`). Those sections look like the following:
   `<location path="WL">
   <system.web>
   <authorization>
   <allow users="*" />
   </authorization>
   </system.web>
   </location>`

6. This step only applies to IIS 6.
   For correct display of ‘Not Found’ error page add section `<customErrors>` after `<authorization>` section to be the following
   `<customErrors mode="On" defaultRedirect="/~/Error.aspx">
   <error statusCode="404" redirect="/~/ErrorPages/404.htm" />
   </customErrors>`
   The page referenced here is the same 404.htm that was configured in IIS settings. This “Not found” error page configuration is also used for standard authentication mode.
6.4.4. Reverting Back to Standard Authentication

To switch from Windows Authentication mode back to standard authentication mode, the following adjustments to IIS are required:


Please refer to Step 2 of section 6.4.1. Disable Windows Authentication and enable both, Anonymous and Forms Authentication.

IIS 6 (Windows Server 2003)

Please refer to Step 3 of section 6.4.2. Disable Windows Authentication and enable Anonymous Authentication.

Changes to Web.config

Get the back up file which was done at the beginning of the configuration process.

6.5 Configuring SSL for Web Verifier

For information how to set up SSL on your Information Services machine please refer to:
http://support.microsoft.com/kb/299875

6.6 Configuring Additional Languages

Web Verifier supports an extended list of languages:

Chinese Simplified, Chinese Traditional, Danish, Dutch, English, French, Finnish, German, Italian, Japanese, Korean, Norwegian, Polish, Portuguese, Romanian, Russian, Spanish, Swedish, Turkish.

Note: By default, the Chinese language selection points to Traditional Chinese. In case Simplified Chinese language has to be used, the content of the Bin\Resources\cmn folder can be copied into the "zho" folder which contains the Traditional Chinese. Prior to overwriting the "zho" folder content, please back it up..

6.7 Virus Check

Please note, that the settings for the Virus Checker on the Web Server exclude the [Local Temp Folder]/CdrDbCache directory (Batch and the Common Learnset folders) from the locations which are checked for viruses. This is due to performance considerations.

6.8 Enabling New Columns for Batch View

Four additional columns are available to hold additional information on batches:

- Batch.ExternalGroupId - default display name: "User Group"
  data type: The Group ID which has been assigned to a batch is relating to security. Batches can be assigned to user group via a unique ID. For example, German invoices belong to Group 1 and English invoices belong to Group 2. When in a shared service center, you could hide all German invoice batches from English Verifiers.

- Batch.ExternalBatchId - default display name: "Batch Group"
  data type: It allows the developer to uniquely identify the batch. For example, external system ID, storage box ID, etc.

- Batch.TransactionId - default display name: "Transaction"
data type: It allows the developer to synchronize a newly created batch of documents with another external system. It can be used to identify originators of batch of documents.

- **Batch.TransactionType** - default display name: "Transaction Type"
  data type: It allows the developer to synchronize a newly created batch of documents with another external system. It can be used to identify the types of documents (Invoices, Claim forms etc.) in batches or source of document (Email, Scanned etc.)

These table columns are not Brainware Distiller project or application specific and therefore cannot be configured in Designer or Verifier or RTS applications.

By default, these columns will be invisible. To configure the columns’ visibility for Web Verifier, adjust the batch columns’ attributes in the batchColumnVisibility section of the web.config file appropriately (please refer to Appendix A).

The values of the columns can only be set via the Project Script (PostimportBatch). Check the SQL scripts in the installation folder to activate the displaying of those columns. After enabling one or all of the additional columns in database, it applies to all application modules.

The additional columns can be enabled with columns customized.

**Syntax:** `exec sp_SetGlobalApplicationSetting 'ColumnSettingName', 'Column Name to Display', Enabled boolean`

**Examples:**

```sql
exec sp_SetGlobalApplicationSetting 'SysAppBatchColumnExternalGroupId', 'User Group', True
exec sp_SetGlobalApplicationSetting 'SysAppBatchColumnExternalBatchId', 'Batch Group', True
exec sp_SetGlobalApplicationSetting 'SysAppBatchColumnTransactionId', 'Transaction', True
exec sp_SetGlobalApplicationSetting 'SysAppBatchColumnTransactionType', 'Transaction Type', True
```

**Note:** For setting up the Group ID column, due to the security control, make sure the group ID is matching with the ID created for the users.

### 6.9 Changing Custom Column Names

After you have enabled new custom columns following the instructions in section 6.8, Enabling New Columns for Batch View, you may want to give them more meaningful names.

#### 6.9.1. Custom Column Names for Web Verifier

To change the custom column names for the Web Verifier application:

1. Navigate to C:\Program Files (x86)\Brainware\Brainware Distiller Web Server\Bin\Resources\eng
2. Open the file in notepad: Brainware.Verifier.WebClient.resx
3. Change the name of the four items below by adjusting the value parameter (highlighted in red in the sample below):

   Example:
   ```xml
   <data name="TEXT_EXTERNALBATCH_NAME" xml:space="preserve">
     <value>External Batch ID</value>
   </data>
   ```
For the other application languages, repeat the steps outlined above using the appropriate Brainware.Verifier.WebClient.resx file from the appropriate folder under:
C:\Program Files (x86)\Brainware\Brainware Distiller Web Server\Bin\Resources\....

6.9.2. Custom Column Names for Thick Verifier Client

For the Thick Verifier Client, custom column names can be changed via SQL Script. Run the below mentioned script by changing the 'Column Name to Display' value.

Syntax:
exec sp_SetGlobalApplicationSetting 'ColumnSettingName', 'Column Name to Display', Enabled Boolean

Example:
exec sp_SetGlobalApplicationSetting 'SysAppBatchColumnExternalGroupId', 'User Group', True

6.9.2.1. Global Application Setting Configuration

This setting is taken place in SQL server, and it enables/disables Workflow History Reporting, disables Batch Deletion in Designer/ MMC, and enables some additional custom columns.

This feature allows user to enable/disable for Document Level, Field Level, table Level, Classification, Document Separation, Learning, etc.

Note: This feature is only available for the Database.

To execute the setting:
1. Launch the SQL Server Management Studio.
2. Point to the Brainware Database.
3. Type in the following script:

exec sp_SetGlobalApplicationSetting 'SysAppHistoryReportingActivatedForDocument', 'True', True

Figure 6-18: SQL Server

Setting Name is the text name of the setting to be modified for application.

Setting value is the text value to configure for it.
**Status Flag** contains True (Setting enabled) or False (Setting disabled). This is disabled by default in the current version of Brainware Distiller.

To enable item with Document Level:

```sql
exec sp_SetGlobalApplicationSetting 'SysAppHistoryReportingActivatedForDocument', 'True', True
```

To enable item with Field Level:

```sql
exec sp_SetGlobalApplicationSetting 'SysAppHistoryReportingActivatedForField', 'True', True
```

To enable Batch Deletion in Designer (Default setting):

```sql
exec sp_SetGlobalApplicationSetting 'SysAppBatchDeletionDisabledInDesigner', 'True', False
```

To disable Batch Deletion in Designer:

```sql
exec sp_SetGlobalApplicationSetting 'SysAppBatchDeletionDisabledInDesigner', 'True', True
```

To enable Batch Deletion in RTS (Default setting):

```sql
exec sp_SetGlobalApplicationSetting 'SysAppBatchDeletionDisabledInRTS', 'True', False
```

To disable Batch Deletion in RTS:

```sql
exec sp_SetGlobalApplicationSetting 'SysAppBatchDeletionDisabledInRTS', 'True', True
```

![Delete Batch Function is Disabled in RTS](image)

**Figure 6-19: Delete Batch Function is Disabled in RTS**

It takes immediate effect right after you have configured it in the SQL Server and it applies to all users under the Brainware Database.
Chapter 7  Security

7.1  Brainware Distiller Security

7.1.1. Project Security

Brainware Distiller contains an internal application security model with 5 project security roles:

- **Administrator**: The Administrator’s role (ADM) is to manage users, groups, and user-to-group assignments. Administrators install the system, configure applications, and manage data. They also design and maintain projects. This role is the most powerful of the roles because it is the highest role within Brainware Distiller.

- **Learnset Manager**: The Learnset Manager (LSM) role is used to define, modify, and maintain the global project Learnset. Reference Brainware Distiller Designer and Verifier documentation for additional information.

- **Supervised Learning Verifier**: The Supervised Learning Verifier (SLV) role is to collect and manage the local training data. These verifiers are subject-matter experts who can propose Learnset improvements.

- **Verifier User**: The Verifier role (VER) is to make document correction that could not be automatically processed. Typically members of this group are data correction users.

- **Setting Role**: The Verifier Settings (SET) role is used to give permission to the Verifier (VER) to alter or access the verifier configuration settings.

- **Filtering Role**: The filtering role (FLT) is to allow Verifier user to configure custom filtering of batches. By application design, FLT users would be able to use the filtering feature even if they do not have the SET role. This solution provides more flexibility and security.

*Note: Additional information on adding users and groups can be found in the Designer documentation.*

7.1.2. Project & Windows Authentication Security

Local workstations and network Windows users can be imported into the Brainware Distiller project authentication sub-system allowing automatic project authentication with the currently logged in Windows user account for all Brainware Distiller applications.

To enable Windows based authentication in Brainware Distiller for a desired Brainware Distiller project:

1) Open the corresponding project file in the Brainware Distiller Designer application

2) Select Options, Users, Groups and Accounts… menu item

3) Enable *Allow Windows Authentication* check-box on the *Users* tab of the *Project Authentication Settings* dialog
When using Database Authentication in Verifier, access rights have to be granted to the verifier user.

By default, this should be:
- Read and Write to all database tables
- Execute rights to stored procedures and functions.

### 7.2 File System Security

Although Brainware Distiller does provide application-level security, the product relies on integrated Windows file system security built into the underlying operating system for file system access.

Brainware Distiller uses operating system files (.sdp, .dat, .wdc, .sdb, etc.) to store all application and project data. A combination of shared and NTFS permissions are used to protect application data.

NTFS file and folder permissions are used to control the type of access that a user, group, or application has to folders and files. This includes everything from reading the contents of a folder or a file to modifying a folder’s contents and/or executing individual files. There are five basic NTFS file and six folder permissions:

<table>
<thead>
<tr>
<th>File Permission</th>
<th>Access Granted</th>
</tr>
</thead>
<tbody>
<tr>
<td>Read</td>
<td>Allows the user or group to read the file and view its attributes, ownership, and the permissions set.</td>
</tr>
<tr>
<td>Write</td>
<td>Allows the user or group to overwrite the file, change its attributes, view its ownership, and view the permissions set.</td>
</tr>
<tr>
<td>Read and Execute</td>
<td>Allows the user or group to run and execute the application. In addition, the user can perform all duties allowed by the Read permission.</td>
</tr>
</tbody>
</table>
File Permission | Access Granted
---|---
Modify (CHANGE) | Allows the user or group to modify and delete a file including performing all of the actions permitted by the Read, Write, and Read and Execute NTFS file permissions.

<table>
<thead>
<tr>
<th>Folder Permission</th>
<th>Access Granted</th>
</tr>
</thead>
<tbody>
<tr>
<td>Read</td>
<td>Allows the user or group to view the files, folders, and subfolders of the parent folder. It also allows the viewing of the folder attributes, ownership, and permissions.</td>
</tr>
<tr>
<td>Write</td>
<td>Allows the user or group to create new files and folders within the parent folder, view folder ownership and permissions, and change folder attributes.</td>
</tr>
<tr>
<td>List Folder Content</td>
<td>Allows the user or group to view the files and subfolders contained within the folder.</td>
</tr>
<tr>
<td>Read and Execute</td>
<td>Allows the user or group to navigate through all files and subfolders, and to perform all actions allowed by the Read and List Folder Contents permissions.</td>
</tr>
<tr>
<td>Modify (CHANGE)</td>
<td>Allows the user to delete the folder and perform all activities included in the Write and Read &amp; Execute NTFS folder permissions.</td>
</tr>
<tr>
<td>Full Control</td>
<td>Allows the user or group to change permissions on the folder, take ownership of it, and perform all activities included in all other permissions.</td>
</tr>
</tbody>
</table>

**Table 7-1: NTFS File Permissions**

**Table 7-2: NTFS Folder Permissions**

The difference between NTFS file and folder permissions is the “List Folder Contents NTFS” folder permission. NTFS folder permissions enable system administrators to limit a user’s ability to browse through a tree of folders and files. This is useful for securing a specific directory such as an application directory. A user must know the name and location of a file to read or execute it when this permission is applied to its parent folder. However, in a Brainware Distiller environment, client applications in the product suite, instead of Windows Explorer, are used to process project data. The intent of file and folder permissions is to minimize the probability of accidental or malicious data destruction.

Shared permissions serve for purposes similar to NTFS permissions: They help protect files from unauthorized access. If you are a member of the Administrators or Power Users group, you can share folders on a local computer so that users on other computers can access those folders over the network. By assigning shared folder permissions to any shared folder, you can restrict or allow access to those folders over the network. Use NTFS folder permissions if the shared folder is located on a NTFS drive. NTFS permissions are effective on the local computer and over the network.

For more information regarding folder permissions, reference [Appendix B](#).

### 7.3 Access to Project Data

Brainware Distiller uses a hierarchical file structure to store project-related data. The project directory is at the highest level of this structure.
All Brainware Distiller components (including services, applications, license engine, and users) need appropriate access rights to the project directory and all of its subfolders.

See section 7.2 File System Security for details on how to enable access to project data.

Once Brainware Distiller has been installed, configured, and prepared for production, appropriate file access security should be applied to the project directory before releasing the implementation to the general user community. A correct application of file access security can prevent unauthorized access to project data while granting access to authorized users.

To apply file access security to the Brainware Distiller project directory:

2) Launch Windows Explorer on the Brainware Distiller server (or the server containing the project directory).

3) Locate the project folder, right click the folder name, and select Properties.

4) In the Properties dialog box, go to Sharing tab.

5) Click Share this folder.

6) In the Share name field, type a name for the share.

7) Click Permissions. In the Share Permissions dialog box, do the following tasks, and then click OK:
   - Add the local Brainware Distiller group with Full Control permission
   - Add the local Brainware Distiller Users group with Change permission
   - Add the local Administrators group with Full Control permission
   - Remove the Everyone group

8) Go to Security tab.

9) Do the following tasks and click OK when finished:
   - Add the local Brainware Distiller group with Full Control permission
   - Add the local Brainware Distiller Users group with Change permission
   - Add the local Administrators group with Full Control permission
   - Remove the Everyone group

Note: The Brainware Distiller and Brainware Distiller Users groups are local groups. The Brainware Distiller local group should be created on all Brainware Distiller servers and RemoteAdmin machines; the Brainware Distiller Users local group is only required on the Brainware Distiller server storing the project data. For an explanation of these groups, see next section.

7.4 Accounts and File Access Security

Access to project data in a Brainware Distiller implementation should be granted using a combination of Discretionary Access Control (DAC) and Role-based Access Control (RBAC).

The Discretionary Access Control model allows the owner of objects or resources (in this context, a System Administrator) to control who accesses them and what operations they can perform. For example, a System Administrator who creates a share called “Projects” to
hold data pertaining to a particular Brainware Distiller project can control and dictate (per the organization’s security policy and business rules) who can access the items within the share.

The Role-Based Access Control model, also referred to as a non-discretionary model, makes access decisions based on the rights and permissions granted to a role or groups, instead of an individual. In this model, System Administrators create roles (or groups), and then assign rights and permissions to the role (or group) instead of directly to a user; users are then placed into a role (or group) and inherit the rights and permissions assigned to the role (or group).

The following table lists the recommended groups and accounts that should be created for each implementation of Brainware Distiller:

<table>
<thead>
<tr>
<th>Group/Account Name</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>Brainware Distiller ProjectUsers</td>
<td>Global group containing all users designated as a Brainware Distiller project designer and/or data verifier within an organization.</td>
</tr>
<tr>
<td>Brainware Distiller Admin</td>
<td>Global group containing all users designated as a Brainware Distiller System Administrator within an organization. This group should be added to the local Brainware Distiller group on all RTS servers and RTS Remote Admin workstations.</td>
</tr>
<tr>
<td>Brainware Distiller</td>
<td>Local group used to grant access to local Brainware Distiller resources; the Brainware Distiller Admin global group should be added to its membership. Create this group on all Brainware Distiller Server and RemoteAdmin machines.</td>
</tr>
<tr>
<td>Brainware Distiller Users</td>
<td>Local group used to grant access to the project directory. Add the global group Brainware Distiller ProjectUsers to its membership. Create this group on the Brainware Distiller server housing the project directory.</td>
</tr>
<tr>
<td>Brainware Distiller RTSsvc</td>
<td>Service account used to start the Brainware Distiller Service Manager. This user should be a member of the Brainware Distiller Admin global group and the local Administrators group on all Brainware Distiller servers and Remote administration machines.</td>
</tr>
</tbody>
</table>

Table 7-3: Recommended Group/Account Names for Brainware Distiller.

The following table lists the groups and accounts, assigned permissions, and the folders/objects on which the permissions should be applied for each implementation of Brainware Distiller:

<table>
<thead>
<tr>
<th>Group/Account Name</th>
<th>Permission Type: Shared</th>
<th>Permission Type: NTFS</th>
<th>Folder/Objects Assigned On</th>
</tr>
</thead>
<tbody>
<tr>
<td>Brainware Distiller</td>
<td>Full Control</td>
<td>Full Control</td>
<td>C:\Program Files[company][ProjectName]</td>
</tr>
<tr>
<td>Brainware Distiller Users</td>
<td>Change</td>
<td>Modify</td>
<td>C:\Program Files[company][ProjectName]</td>
</tr>
</tbody>
</table>

Table 7-4: Group/Account and Permissions.

For a comprehensive list of security settings and options, see Appendix B.

7.5 Configuring the Service Account for Brainware Distiller

7.5.1. Running Brainware Distiller on a Domain Network

Brainware Distiller Runtime Server Service utilizes a Windows Service which runs in the Server background. This Service manages the operation of Runtime Server Instances, and processing of documents automatically.
When running Brainware Distiller on multiple servers located on a Domain Network, it is recommended that the Brainware Distiller Runtime Server Service is assigned a Domain user against the Windows Service. This will allow Brainware Distiller to communicate with all servers running the service across the Domain.

The Service Account used in Brainware Distiller is also given permission to any file/folder shares across the servers to allow the Brainware Distiller Runtime Server service access to all project related files.

7.5.2. System Monitoring

The System Monitoring service is used to send email notification to selected users to notify of any errors, or warnings, that any Runtime Server instance may raise during its operation.

The Service User Account used for System Monitoring should have sufficient rights to be able to send emails on the server and Domain.

7.5.3. Email Importing and Service User Accounts

Brainware Distiller provides the ability to perform email importing, automatically downloading emails from a Mail Box account and importing it into the Brainware Distiller system. The Brainware Distiller Runtime Server Service must have sufficient access rights to be able to access the mailbox in order to download emails for process.
Chapter 8  Configuring Runtime Components

Once you install Brainware Distiller you must configure the Runtime Service Manager before you can use the application.

8.1 Before Configuring Components

Check the following pre-installation steps before you configure Runtime Components. Before starting the Brainware Distiller Runtime Service Manager on a license server (a machine equipped with a hardware-key intended to provide a shared network copy of the license file to other Brainware Distiller machines) or a standalone machine (laptop or an autonomous Brainware Distiller machine), ensure that:

- A hardware key is installed
- The corresponding license file for the installed hardware key is copied to the …\Brainware\Components\Cairo directory
- The demo license file, zCroDemo.lic, is deleted from the …\Brainware\Components\Cairo directory

8.2 Configuring the Runtime Service Manager

Below are the steps required for configuring the Runtime Service Manager. Administrator rights are needed to do these steps:

1) Click Start on the lower left of your screen.
2) Click Run.
3) At the command window, type “services.msc” and press Enter.

![Figure 8-1: Runtime Service Manager in Services](image)

4) In the Scope panel, double click the Brainware Distiller Runtime Service Manager.
5) On the General tab, under Startup type, select Automatic from the drop down list.

6) Go to Log On tab.

7) Under Log on as, select This account.

8) Click Browse…

9) Find and add the domain user with appropriate and sufficient for Brainware Distiller processing network access rights (e.g. Brainware Distiller RTSsvc), and then click OK.

10) Type the domain password for the user in the fields provided.

11) Click Apply and OK, and then close the Computer Management MMC.
8.3 Configuring the RTS RemoteAdmin MMC Snap-in

The installation of Brainware Distiller creates a default console, called Brainware Distiller Service Manager that you can use to configure the Brainware Distiller RTS RemoteAdmin MMC snap-in.

**Very Important!**

Before configuring the RemoteAdmin MMC snap-in, make sure that the steps outlined in section 8.2 have been performed and the Runtime Service Manager is started. Unless the service has been started, the MMC will not connect to the machine.

1) Launch the Brainware Distiller Service Manager MMC snap-in by selecting Start>Programs>Brainware>Brainware Distiller>Brainware Distiller Runtime Service > Management Console on the desktop of the target machine. The Brainware Distiller Service Manager MMC console appears.

![Figure 8-4: The administration console](image)

2) Right click the Brainware Distiller Runtime Server node and select New Brainware Distiller RTS Group from the context menu.

3) On the New Group dialog, type a group name and click OK.

4) Expand the Brainware Distiller Runtime Server node, right click the group you created, and then select New Machine.

5) In the Domains dropdown, select the domain where the machine being configured locates.

![Figure 8-5: Group management of runtime service](image)
6) On the Group Management dialog box, type the name of the Brainware Distiller server and click OK.

![Image 1](https://via.placeholder.com/108x738)

Figure 8-6: Administration console with added machine

7) Right click on the machine name. Select License, and set the license path.

8) Right click on the machine name and select New>RTS Instance

9) On the New RTS Instance dialog, type the instance name and then click OK. The configuration for RTS RemoteAdmin MMC snap-in should look like the example in Figure 8-7.

![Image 2](https://via.placeholder.com/108x738)

Figure 8-7: Administration console with instance

See Also

For information on how to configure project settings for a Brainware Distiller instance, see the Brainware Distiller Runtime Server User’s Guide.

8.4 Configuring E-mail Import

Below are the steps required to configure the E-mail Import feature for Microsoft Office 2003. They may be slightly different for other versions of Microsoft Office.

1) Launch the Windows Control Panel and select the Mail option

   Note: Microsoft Outlook must be installed before this option appears in the Control Panel.

2) Click Show Profiles…. Click Add… and create a new profile named RTS_Import, and then click OK.

3) Select Add a new E-mail account and then Next. Select Microsoft Exchange Server.
4) Enter the name of your Microsoft Exchange Server. Switch off *Use Cached Exchange Mode*. Enter the *User Name* and click *Check Name* to make sure that mailbox is recognized.

5) Click *Next* then click *Finish* to create the account and close the wizard.

6) Open your ".\Brainware\Brainware Distiller" folder in Windows Explorer and create a batch file containing the following line: “DstHost.exe /TestMailUI”. Run the batch file. The Outlook logon screen should appear.

7) Enter “[your domain name][your user name]” as the user name and your password. Check the *Remember password* option otherwise your RTS service may not work.

8) Open the latest “I_YYYYMMDD_Brainware Distiller RuntimeServiceHost_PID.log” file in the “."\Brainware\Brainware Distiller\Log” folder and verify whether the login was successful by checking for the message: “Managed to open the folder ‘Inbox’” or any corresponding errors.

9) Create and run another batch file containing the following line: “DstHost.exe /TestMail”. You should get the same message in the log file as in the previous step i.e. “Managed to open the folder 'Inbox’”, but without any dialog asking you for the user name and password.

10) See the Brainware Distiller *Runtime Server Guide* to complete the configuration process.

### 8.5 Advanced Logging

The standard Runtime Server Log includes System Level Resource information and, in the event of a system crash or failure, special error logs.

#### 8.5.1 System Resource Logging

In the Brainware Distiller\bin\Log folder, the log files for the different Brainware Distiller components can be found as following:

- V_ log file for Verifier messages, e.g. any custom script errors would be logged there.
- H_ log file for Runtime Server messages.
- VA_ log file for Advanced Verifier messages.
- L_ log file for Learnset Manager messages, e.g. when the user triggers document learning, or when a backup of the Learnset is taken, etc.
- D_log file for Designer messages (including scripting errors).
- U_log file for Unknown/External application messages.
- S_log file for Standart Service Manager messages.

The I_ log files are component log files for all applications and are written to by the application during the normal running.

Examples for file name syntax, e.g. for the Runtime Server log file:

- [Application directory]\bin\Log\H_<instance name>_yyyymmdd.log

  For example:
  C:\Program files\Brainware\Brainware Distiller\bin\Log\H_Test_20100203.log

**Standard Service Manager log file:**

- [Application directory]\bin\Log\S_yyyymmdd.log

  For example:
  C:\Program files\Brainware\Brainware Distiller\bin\Log\S_20100203.log
The following System Resource information has been added to the log files:

- Available physical memory (in kb).
- Used physical memory (in kb).
- Available virtual memory (in kb).
- Used virtual memory (in kb).
- Virtual memory used by this RTS host instance process (in kb).
- Physical memory used by this RTS host instance process (in kb).
- Handles used by the process (in number of handles).
- GDI resources used by the process (in number of handles).
- User Objects used by the Process (in number of Objects).

Using the following format:

<table>
<thead>
<tr>
<th>Entry Nr.</th>
<th>Entry Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Type of message (info, warning, error, etc)</td>
</tr>
<tr>
<td>2</td>
<td>Severity of message</td>
</tr>
<tr>
<td>3</td>
<td>Time logged</td>
</tr>
<tr>
<td>4</td>
<td>Process ID (PID)</td>
</tr>
<tr>
<td>5</td>
<td>Overall used/available physical memory</td>
</tr>
<tr>
<td>6</td>
<td>Overall used/available virtual memory</td>
</tr>
<tr>
<td>7</td>
<td>Used physical/virtual memory by this Runtime Manager</td>
</tr>
<tr>
<td>8</td>
<td>Process handles used by this Runtime Manager</td>
</tr>
<tr>
<td>9</td>
<td>GDI resources/UserObjects used by this Runtime Manager</td>
</tr>
<tr>
<td>10</td>
<td>Message Description</td>
</tr>
</tbody>
</table>

Table 8-1: Log files format

S_log example:

[Info] |30| 00:35:26.146 |  2628 | 2663792k/14110392k | 2983264k/24429476k | 51660k/18932k | 154 | 4/14 | Sent '13' to Host '5.2FullSetup-RTS' Conn: 1

H_log example

[Info] |20| 01:00:57.656 |  5584 | 1005944k/15768240k | 1097012k/26315728k | 8276k/7004k | 84 | 4/5 | Username: SYSTEM, Computername: WIN-RSL5FCPK7A4

8.5.2. Crash / Failure Logging

In the case of a System or Application Crash or Failure an additional error log file will be created with a format:
C_<Process ID>_yyyymmdd.log

This will log crashes under the following circumstances.

- **Import Crashes** - The log file will have stack information specific to the status of the system when the crash/failure occurred.

- **OCR Engine Crashes** - The log file will have a "ReadZone" entry for the specific OCR engine for which the crash occurred and stack information specific to the status of the system when the crash/failure occurred.

- **Classification Engine Crashes** - The log file will have a "Classify" entry for the specific Classification engine for which the crash occurred, the specific Class name where the crash occurs, and stack information specific to the status of the system when the crash/failure occurred.

- **Extraction Engine Crashes** - The log file will have an "EvalZone" entry for the specific Extraction engine for which the crash occurred, the field where the crash occurs, and stack information specific to the status of the system when the crash/failure occurred.

- **Export crashes** - The log file will have a "StepExport" and stack information specific to the status of the system when the crash/failure occurred.

- **Clean-up crashes** - The log file will have a "ProcessDocumentsCleanUp" and stack information specific to the status of the system when the crash/failure occurred.

- **Script Events** - The name of the script event, which could be project level or a certain class. For script events on field level, the field name will be added to the crash/failure log.
Chapter 9  Auto-Update of Brainware Distiller Verifier & Runtime Server Software Versions

9.1  Description

9.1.1.  How the Automatic Update Works

The auto update feature allows the Administrator to update automatically Brainware Distiller software versions with latest available service updates on different workstations where Brainware Distiller applications are running. For this purpose, it is required to set up a “Shared Network Folder” where the new service updates are to be placed.

The workstations must have sufficient file access permissions to access this shared directory.

Furthermore, a Local Update Folder has to exist for each workstation, where automatic updates are to be configured. Through this directory, the system will check which software builds have already been installed.

There are three files to be copied to the Shared Network Folder to enable automatic updates:

- One system file (called “Build Level” file for further reference) identifies the build level of the service update to deploy automatically (for example, “B4117.installed”).
- The service update to deploy automatically. (It is recommended to define a unique name associated with execution of service update installations, for example “Setup.exe”.)
- One batch file for execution of the service update in Silent Mode (“InstallRemote.bat”).

When starting the Verifier (or Designer/RTS applications) the batch file will check whether the same “Build Level” file located in the “Shared Network Folder is already available in the Local Update Folder.

1. If this is not the case, the "InstallRemote.bat" is going to be invoked. After completion of the silent installation, the “Build Level” file from the Shared Network Folder is going to be copied to the Local Update Folder directory and the Verifier (or the other desired application) is going to be started.
2. In case the same “Build Level” file is already available in the Local Update Folder, the silent update step is going to be skipped and only the launching of the application is going to take place.

3. In order to auto-update the Runtime Server (RTS) software version, the RTS service has to be stopped first. It is recommended to apply this operation when the RTS is not loaded with the document processing activities. For this purpose the Windows "Winat" function can be used, which can be configured to:

- Stop the RTS service at the specific desired time (e.g., via usage of the "Stop RTS running as NT Service.bat" from the application directory of Brainware Distiller).
- Start the auto-update feature (the file "AutoInstall.bat" from the Brainware Distiller application directory contains all required instructions). Note: The enclosed file paths have to be adjusted manually.
- Start the RTS service at the desired time (e.g., via usage of the "Start RTS as NT Service.bat" from the application directory of Brainware Distiller).

The used batch files are going to be created during the full setup installation of Brainware Distiller. In case the Auto Update feature was not configured during the installation, the used file paths have to be entered/adjusted in the following batch files (after the installation): "StartIfNotInstalled.bat", "AutoInstall.bat". In order to enable the auto update feature for the Verifier and Designer applications, they have to be started via the corresponding "DstVer_AutoUpdate.bat" (or "DstDsr_AutoUpdate.bat") from the Brainware Distiller application directory.

9.1.2. Configuring Auto Update in Brainware Distiller Setup

During the Brainware Distiller 5.4 SP1 installation, the setup will show a dialog box for configuring of the Auto Update feature.

In order to configure the auto update during the installation, the Shared Network Folder path has to be known before launching the Brainware Distiller setup. The administrator can also activate the automatic update for Verifier and/or Designer applications using the corresponding Designer and Verifier check-box controls available in the dialog (by default, both are deactivated).

The options have the following implication:

Activation of Designer and/or Verifier options: The program shortcuts do not call the corresponding application directly any longer. Instead they use the generated (by the setup) batch files “DstDsr_AutoUpdate.bat” and/or “DstVer_AutoUpdate.bat” correspondingly.

Note: these options can be activated only if the entered “Shared Network Folder” path is valid.

Entering of the Shared Network Folder path: The setup will use this path when generating the batch files for auto update function (See section 9.1.1 How the Automatic Update Works above).

9.1.3. Manual Configuration of the Auto Update Function

In case the Auto Update feature was not properly configured during the Brainware Distiller 5.4 SP1 installation (for example, due to the reason that exact location of the Shared Network Folder was unknown at the point of the installation), it is still possible to configure it manually afterwards. The following steps are going to be required.

9.1.3.1. Editing the “AutoInstall.bat” Batch File

The path Shared Network Folder has to be entered in the “AutoInstall.bat”. For this purpose, edit the “AutoInstall.bat” batch file using, e.g., Windows Notepad application (right click on the “AutoInstall.bat” file in Windows Explorer, select Edit menu item).
@echo off
REM
====================================================================================================
===== REM This Batch file checks the Shared Network Install folder ("SHAREDNETFOLDER" variable) for available
REM software service updates.
REM Please adjust the "SHAREDNETFOLDER" variable with your network path, where new service updates are
REM going to be placed for automatic installation by Verifier and/or Runtime Service workstations.
REM
REM Example: \Your File Server\Your Brainware Distiller Service Update Share
REM
REM "ACTIVEDIR" variable: Location of this batch file (generated automatically by the Brainware Distiller setup).
REM
REM (c) 2008 Brainware, Inc.
REM
====================================================================================================
===== SET SHAREDNETFOLDER ="\YourNetworkInstallServerName\YourInstallShareName"
SET ACTIVEDIR ="C:\Programme\Brainware\Brainware Distiller"
IF EXIST %SHAREDNETFOLDER %\*.installed GOTO NEW SU
echo no.updates.available.root
GOTO END
:NEW SU
CD %SHAREDNETFOLDER %
for %%1 in (*.installed) do Call %ACTIVEDIR %\StartIfNotInstalled %%1 %SHAREDNETFOLDER % %ACTIVEDIR %
CD %ACTIVEDIR %
:END

Change the content of the variable “SHAREDNETFOLDER” to the network location of the new service updates that is going to be used as the master location of the software setups for Auto Update feature.

9.1.3.2. Change Shortcuts

The shortcuts used to start Designer and/or Verifier applications (Available in Windows Start menu and/or on the desktop) invoke the corresponding programs directly, in case the Auto Update function was not configured during the setup.

In order to adjust this, replace the target file “DstDsr.exe” (or “DstVer.exe” for the Verifier application’s shortcut) with the batch file DstDsr_AutoUpdate.bat” (or “DstVer_AutoUpdate.bat”) in the Properties of the corresponding application’s shortcut (Right click on the shortcut and select the Properties menu item).

9.2 Usage

The Auto Update feature can be used for automation of the Brainware Distiller installation process and can save time in administration efforts to deploy future software update on, e.g.,
100 different production developments, and testing workstations and servers where Brainware Distiller is running.
Chapter 10 Enabling Additional OCR Engine Languages

Brainware Distiller supports many OCR engine languages. The FineReader 10 engine supports Asian languages such as Japanese, Chinese, Thai, and Korean. The main languages, English, French, German, Spanish, and Italian are enabled by default, but for some OCR engines you can request additional recognition languages at Brainware.

Brainware will confirm that the requested language is effectively supported by the desired OCR engine and will deliver special custom language files in this case.

10.1 To Enable a Language for an OCR Engine

A language can only be processed by Brainware Distiller if it is installed on the server machine, and if it is present in the FineReader directory:

1. Exit all Brainware Distiller applications.
2. On the Brainware Distiller servers, stop the Brainware Distiller Runtime Server services.
3. Copy the custom language file(s) received from Brainware to the .\Langfile sub-folder on your local system.
4. Copy the language file to the appropriate FineReader folder:
   for instance: .\Brainware\Components\Cairo\Finereader8 on all configured Brainware Distiller machines.
5. Restart the Brainware Distiller Runtime Server services.
6. Restart the client application.

Note: If not already done, you first have to enable the support of double byte and extended ASCII character sets, (Greek, CJKT, Russian, Hebrew) for your system. The steps depend on your operating system:

10.2 To add Input Language for Windows 7

1. Select Start → Control Panel → Clock, Language, and Region → Region and Language.
2. Click the Keyboards and Languages tab.
3. Click Change keyboards.
4. Under Installed services, click Add.
5. Double-click the language you want to add, double-click Keyboard.
6. Select the text services options you want to add.
7. Click OK to confirm.

10.3 To add Input Language for Windows XP

1. Select Start → Control Panel → Language and Regional Options.
2. Select the Languages tab.
3. Check the two check boxes for Supplemental language support.
4. Click Apply.
5. Reboot the machine.
10.3.1. To add Input Language for Windows Vista

1. Select Start → Control Panel → Clock, Language, and Region → Regional and Language Options.
2. Click the Keyboards and Languages tab.
3. Click Change keyboards.
4. Under Installed services, click Add.
5. Double-click the language you want to add, double-click the text services you want to add.
6. Select the text services options you want to add.
7. Click OK to confirm.

10.3.2. To add Input Language for Windows 2008

1. Select Start → Control Panel → Regional and Language Options.
2. Click the Keyboards and Languages tab.
3. Click Change keyboards.
4. Under Installed services, click Add.
5. Double-click the language you want to add, double-click the text services you want to add.
6. Select the text services options you want to add.
7. Click OK to confirm.

10.3.3. To add Input Language for Windows 2003

1. Select Start → Control Panel → Regional and Language Options.
2. Select the Languages tab.
3. Under Supplemental language support, check the two check boxes.
4. Click OK or Apply.
5. Reboot the machine.
Chapter 11 Workarounds

This section summarizes Product Bulletins which provide additional solutions to handle problems within Brainware Distiller.

11.1 General Support Notice on PDF

The following ISO standard PDFs are supported within Brainware Distiller:
- ISO 32000-1:2008

The following PDF filters are supported by Brainware Distiller:
- ASCII85Decode
- ASCIIHexDecode
- FlateDecode
- LZWDecode
- RunLengthDecode
- DCTDecode - JPEG Compression
- CCITTFaxDecode - Standard Fax Compression
- JBIG2Decode - JBIG standard introduced in PDF 1.4. Partial support, please reference later chapters in this document.
- JPXDecode – JPEG 2000 introduced in PDF 1.5.

Brainware Distiller supports both Image and Electronic PDFs.

11.1.1. Embedded Fonts in PDF Files Are Not Supported

This bulletin applies to the following Brainware, Inc. applications and versions
- Brainware Distiller versions 4.1, 5.2

11.1.2. Overview

The Brainware Distiller PDF filter includes robust support for converting PDF text content into Unicode. The process of converting PDF text to Unicode, while seemingly straightforward, is actually fairly complex. Each PDF Text operation includes a string of bytes that represent a series of character codes. The character code is used to select the glyph to be drawn from the current font. Converting each character code to its Unicode equivalent requires that the encoding of the font is well defined or that a Unicode mapping of its character codes is included in the PDF document. There is also the possibility that the characters are tagged with an alternate text replacement definition that overrides the text operation.

Most PDF creation tools follow the recommendations of the PDF specification with regard to creating PDF that allows consuming applications to correctly convert character content to Unicode. In fact, this is a requirement for a class of PDF documents known as Tagged PDF. Unfortunately, there are numerous cases where a PDF document can be created in such a way that it prevents the consuming application from being able to guarantee the mapping of characters to Unicode or any other known character set. In such cases, even though the glyphs are displayed perfectly, there is no way of knowing what character the glyph represents. In many of these cases the consuming application can make certain assumptions.
about the character encoding that allows most characters to be correctly converted. However, even in such cases, the application cannot be sure that the mapping is correct.

11.1.3. Embedded Fonts in PDF Files and Brainware Distiller Support

Brainware Distiller does not support embedded fonts in PDF files. As described in the "Overview" section of this note, some embedded fonts can also specify a custom encoding of the characters in the font, making mapping to standard code pages impossible without embedded font support. As a non-specific example, a custom encoding can be used that has mapped every instance of the character "a" to "&", and the only way to decipher this mapping is to read the encoding information from the embedded file. Otherwise, an application reading the file will see that the file specifies a "&" and extract/display that character. Font rendering is a service provided by the platform GUI (Windows 32). User-level applications are not supposed to reinvent this functionality for their own purposes.

11.1.4. How to Locate Problematic PDF Files with Unmappable Encodings

These types of embedded fonts with custom encodings *may* have font names that do not match standard font naming conventions that you are familiar with (i.e. TT1SC0108137, T1, T2, or some other non-human decipherable string of text), and will be listed in the PDF Document Properties as "Encoding: Custom." They may also have standard naming conventions, but the font used in the file is an embedded subset of the standard font, and the author has chosen to use a custom encoding.

Since Brainware Distiller does not support embedded fonts in PDF files, it cannot read the custom encoding information contained in the embedded font. Without the custom encoding information, the characters in the font do not map to standard code pages or character maps, so the result is incorrectly mapped or "garbage" text in place of the expected result.

You can verify the custom encoding on your own by attempting to copy text from the PDF file in Adobe Reader into another application, such as Microsoft Word. You will also get "garbage" data when copying from Adobe Reader, which should serve as a sign that Brainware Distiller is not going to be able to map the characters correctly.

If your PDF file contains many different fonts and only some of these are mapped incorrectly, you should use the Touch Up Text Tool in Adobe Reader (under the Tools->Advanced Editing menu) to select the problematic text and right-click to see that text's properties. The font will be one of the properties, and you can then see if this is one of the embedded fonts or embedded subset with custom encoding.

To view the encoding used within a PDF file:

- Launch Adobe Reader and open the PDF file
- From the File menu, select the Properties menu item.
- On the Properties dialog box, select the Fonts tab.

11.1.5. How to Avoid Creating Problematic PDF Files – ToUnicode Map

If you have control over the PDF file creation process, one way to ensure the characters will map correctly is to use the 'ToUnicode' map for the fonts in question. As suggested from the name of this tag, ToUnicode provides a direct mapping to Unicode, which will allow Brainware Distiller to map the characters to Unicode values and extract/display/convert them correctly.

11.1.6. Available Workarounds

- Contact the PDF creator and request that the documents provided do not use custom embedded fonts.
- Contact the PDF creator and request the embedded font. The font can be installed on the Brainware Distiller server which is performing the PDF to TIF conversion.
11.2 Acrobat PDFMaker 9.0 for Microsoft Outlook

This bulletin applies to the following Brainware, Inc. applications and versions

- Brainware Distiller versions 4.1, 5.2.

11.2.1. Overview

PDF Portfolios allow you to bring together content from a variety of sources (i.e., PDF, Word, Excel, JPEG files) into one file location.

When opening a PDF Portfolio document, the user is presented with a screen allowing the user to select a file to view, edit, or insert new files.

A PDF portfolio file contains a file extension of PDF.

11.2.2. PDF Files Created in Outlook via Acrobat PDFMaker 9.0 for Microsoft Outlook

Brainware Distiller does not support processing of PDF Portfolio files.

One example of this is PDF Portfolio files which are created within Outlook using Acrobat PDFMaker 9.0. The portfolio file may contain several converted emails to PDF within the Portfolio file.

11.2.3. How to Locate Portfolio PDF Files

The Portfolio PDF files can be identified through Adobe Reader. When opening a Portfolio PDF, the user is presented with a screen that allows them to navigate thru the different documents within the portfolio.

The screenshot below is an example of a PDF Portfolio displaying a collection of emails.

When opening a Portfolio PDF in Adobe Reader, you will also note that the File Menu contains menu items for Portfolio.

11.2.4. Available Workarounds

- Contact the creator of the PDF and request that the PDFs / Documents are provided as separate attachments.
- Open the Portfolio PDF in Adobe Reader and export each attachment out of the Portfolio into the Brainware Distiller import folder.
11.3 Display and Conversion Problems with Character Width or Overlapping Text

This bulletin applies to the following Brainware, Inc. applications and versions

- Brainware Distiller versions 4.1, 5.2.

11.3.1. Character Width and Overlapping Text in Embedded Fonts

Since Brainware Distiller does not support embedded fonts (see earlier Bulletin note), the character widths in the embedded font file cannot be read. In such an occurrence, Brainware Distiller will use the fonts on the operating system to render the characters in the respective fonts. There can be differences in character/glyph width between an embedded font and a standard operating system font; this can lead to conversion problems between the original PDF file and the Brainware Distiller rendering of the PDF file.

One common example is problems with character spacing when converting PDFs to image files within Brainware Distiller.

It is worth noting that not every embedded font is going to have custom width information, so this is not a universal symptom for any PDF file that uses embedded fonts.

11.4 JBIG2 Support within Brainware Distiller – Gray X PDFs

This bulletin applies to the following Brainware, Inc. applications and versions

- Brainware Distiller versions 4.1, 5.2.

11.4.1. Overview

JBIG2 is a compression used mainly within certain PDF files, such as scanned or faxed documents, for which Brainware Distiller includes limited support.

JBIG2 is currently not entirely supported by the Cairo components within Brainware Distiller, so this document discusses the known limitations with JBIG2 support.

When Brainware Distiller processes PDFs using JBIG2 compression, the verifiers may notice one of the following symptoms:

- Pages within the PDF appear as gray with a large X on it.
- Certain sections of the page appear as a gray square with a large X on it. Other sections in the PDF may appear correct.

The Brainware team has seen an increased usage of JBIG2 compression in PDF files in recent months. Due to this increased volume of customer issues, support for JBIG2 is being continuously expanded in each new release, including expanded support for different segment types in the Brainware Distiller release. Even with all the updates in the recent versions, there are still some cases where an image might be omitted or displayed as a broken image.

11.4.2. How to Determine if a PDF is using JBIG2 Compression

When opening the PDF in Adobe Reader, there is no method for ascertaining the compression method used.

One way of determining the compression used within the PDF is to open the PDF in Notepad++ and search for the text below.

`JBIG2Decode`

If this text is found, then the PDF is using JBIG2 compression.
### 11.4.3. JBIG2 and Brainware Distiller Support

Using JBIG2 encoding, a scanned image can be compressed up to 10x smaller than with a TIFF G4 compression (standard Brainware Distiller TIF compression format used). A JBIG2 encoder will segment the input page into regions of text, regions of halftone images, and regions of other data.

This chapter provides a high level description of some JBIG2 ‘features’, also known as ‘Segment Types’.

<table>
<thead>
<tr>
<th>Segment Type</th>
<th>Supported</th>
</tr>
</thead>
<tbody>
<tr>
<td>Symbol Dictionary</td>
<td>Yes (*)</td>
</tr>
<tr>
<td>Text Region</td>
<td>Yes</td>
</tr>
<tr>
<td>Pattern Dictionary</td>
<td>No</td>
</tr>
<tr>
<td>Halftone Region</td>
<td>No</td>
</tr>
<tr>
<td>Generic Region</td>
<td>Yes</td>
</tr>
<tr>
<td>Generic Refinement Region</td>
<td>No</td>
</tr>
<tr>
<td>Page Information</td>
<td>Yes</td>
</tr>
<tr>
<td>Profiles</td>
<td>No</td>
</tr>
<tr>
<td>Tables</td>
<td>No</td>
</tr>
<tr>
<td>Extensions</td>
<td>No</td>
</tr>
</tbody>
</table>

(*) Symbol Dictionary is supported in Brainware Distiller, but there are some exceptions:

- Symbol Dictionary using Huffman decoding is supported ONLY if it is using standard Huffman Tables. Custom Huffman tables are not supported.
- Symbol Dictionary using Symbol Refinement is supported ONLY if a symbol is refined using only one other reference bitmap. There is a case where a symbol is refined using more than one reference bitmap, which is not supported by Brainware Distiller.

### 11.4.4. Available Workarounds

- When encountering PDFs with issues, contact the PDF creator and request that the documents provided do not use JBIG2 Compression.
- If PDFs are generated via scanning, change the compression setting for PDF to use a different compression method, such as CCITTFax.

When encountering an issue with a gray PDF and a large X, please contact Brainware Customer Support and provide them with the problematic PDF for further diagnosis.

### 11.5 Adobe XML Forms Architecture (XFA) PDF Files Are Not Supported

This bulletin applies to the following Brainware, Inc. applications and versions

- Brainware Distiller versions 4.1, 5.2.
11.5.1. Overview

In the PDF 1.5 format, Adobe Systems introduced a new, proprietary format for forms, namely Adobe XML Forms Architecture (XFA) forms.

PDF currently supports two different methods for integrating data and PDF forms. Both formats today coexist in PDF specification:

- **AcroForms** (also known as Acrobat forms), introduced and included in the PDF 1.2 format specification.
- **Adobe XML Forms Architecture (XFA) forms**, introduced in the PDF 1.5 format specification.

AcroForms are the original PDF forms technology. Designed as an integral part of PDF, AcroForms could be described as being "native" to the PDF format. XFA Forms on the other hand are based on XML technology and could not be described in the same way.

Adobe XFA Forms are not compatible with AcroForms. Creating XFA Forms for use in Adobe Reader requires Adobe LiveCycle Forms Designer. Adobe Reader contains "disabled features" for use of XFA Forms, so that will activate only when opening a PDF document that was created using enabling technology available only from Adobe.

11.5.2. Adobe XML Forms Architecture PDF Files and Brainware Distiller Support

Brainware Distiller does not support Adobe XML Forms Architecture (XFA) PDF files. As described in the "Overview" section of this note, this technology is not native to PDF Files.

Brainware Distiller does support AcroForms PDF files.

11.5.3. How to Identify an Adobe XML PDF File

The following methods are available for determining if the PDF is using XFA or not:

- When opening the PDF in Brainware Distiller, there is a message appearing on the document image “Please wait...”. A screenshot of this message is shown below.

  ![Screenshot of please wait message](image.png)

  If this message is not eventually replaced by the proper contents of the document, your PDF viewer may not be able to display this type of document.


- The PDF is created with Adobe LiveCycle Designer. This can be determined by looking at the PDF Producer properties on the document.

11.5.4. Available Workarounds

- Contact the PDF creator and request that the documents provided do not use XFA Formatting.
- Convert the PDF from XFA electronic PDF to an image PDF.
- Print the XFA PDF and scan the document.

11.6 Oversized PDF Files Are Not Supported

This bulletin applies to the following Brainware, Inc. applications and versions

- Brainware Distiller versions 4.1, 5.2.
11.6.1. Overview

Due to deviating settings of magnification level when creating PDF documents, the resulting PDF in some cases might have an oversized image area. Especially the step of specifying the page area during the creation process might be susceptible to errors.

Brainware Distiller is not designed to process oversized PDF files that are greater than A3. When attempting to process an oversized image, the Runtime Server would show an error during OCR saying:

“OCR Error in Engine ‘FineReader8’ at page 1: Error in memory access”.

Processing of further images would then be terminated.

11.6.2. How to Identify an Oversized PDF File

The following methods are available for determining if the PDF is too big:

- When opening the PDF and the magnification is showing a low value, but the page fits entirely in the document pane, it means that when the PDF is at actual size (100%), parts of the image would be out of view and thus, the PDF is more than likely oversized.

- Another way to determine a page size is to show the page at actual size (typically 100%) and to look at the bottom left corner of Adobe Reader, where the page measurements are displayed. Alternatively, the document properties can also provide information on the image/document size.

11.6.3. Available Workarounds

- Please correct the documents at source to reflect the correct image area.

- The following document sizes are supported by Brainware Distiller: A3, A4, A5, A6, Letter, and Legal.

- Image classification engine in a test project can be used to filter out oversized images from processing (processing of Image Classification does not require OCR). A class can be called, e.g. Rescan, with the measurements for oversized images. (see figure below)
11.7 Performance of ASE Update for ORACLE / SQL Server

11.7.1. Overview

There is a known issue where the time taken for an ASE pool update directly from the database can take several hours (applicable to version 4.1 and 5.2). A previous update of 6-12 hours from the database will now take around 5 minutes with the workaround in place.

11.7.2. Available Workarounds

Follow the steps below to make sure a speedy completion of the pool update directly from the database.

1. Launch Windows Register Editor
2. Navigate to HKEY_LOCAL_MACHINE\SOFTWARE\Brainware\ErrorTrace
3. Create DWORD value CdrSupEx
4. Set the new DWORD value to 0 (Logging disabled for ASE update)
5. Restart Distiller Services/Designer for the change to take effect.

11.8 Running Multiple Web Verifier and RTS instances

Problem Description

When running more than approx. 12 concurrent Web Verifier user sessions or more than approx. 14 Runtime Service instances, the Distiller system may start experiencing lack of Windows desktop heap resources and the extra user sessions / RTS instances can be failing with different internal memory allocation errors.

Problem Cause

The default Windows OS setting of desktop heap size for the non-interactive Windows station often appears to be too low to host multiple simultaneously running Distiller Web Verifier or Runtime Service instances with extensive script engine utilization.

Steps to Resolve / Recommended Configuration Changes

1. Open Windows Registry Editor.
2. Browse to the key 
   "[HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control\Session Manager\SubSystems\Windows]".
3. Check / modify the third argument of the "SharedSection" parameter:

   SharedSection=1024,3072,512

   512 (KB) is exactly the default value that causes the issue as described in the "Problem Description" section above.

   Note that for some OS versions, this default setting can be different. The table below gives the recommended values for this setting:

<table>
<thead>
<tr>
<th># of RTS and/or WVC instances</th>
<th>DH Size in KB</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 – 10</td>
<td>512</td>
</tr>
<tr>
<td>11 – 24</td>
<td>1024</td>
</tr>
<tr>
<td>25 – 36</td>
<td>1536</td>
</tr>
<tr>
<td># of RTS and/or WVC instances</td>
<td>DH Size in KB</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>--------------</td>
</tr>
<tr>
<td>37 – 48</td>
<td>2048</td>
</tr>
<tr>
<td>49 – 60</td>
<td>2560</td>
</tr>
<tr>
<td>61 – 72</td>
<td>3072</td>
</tr>
</tbody>
</table>

Legend:

**DH Size**: Desktop heap size for non-interactive window station

**# of RTS and/or WVC**: Cumulative number of simultaneously running Runtime Service instances PLUS number of concurrent Web Verifier users running on the same physical server.

4. After modifying this parameter reboot the server.
Chapter 12 Using Brainware Distiller Licenses

To use Brainware Distiller, you must have a runtime license. The license is stored in a file with the extension *.lic. This file is located in the \Components\Cairo directory of the Brainware Distiller installation. The license file can be updated incrementally as new components are purchased.

To check the current license status, use SCBLibVersion.exe. From the menu, select View>Components Licensing Info to display a list of valid licenses.

![Components Licensing Info](image)

**Figure 12-1: Components Licensing Info**

Only licensed options are available in Brainware Distiller.

The Brainware Distiller installation contains a demo license file, ZcroDemo.lic, which is valid for several weeks. When you receive your permanent license, copy the *.lic file to the license path and remove the demo license file.

Brainware’s licensing model uses a combination of a license file and a corresponding hardware key. For a standalone installation, the hardware key can be attached to a local machine that contains both the server and client components of the Brainware Distiller product suite.

The Brainware licensing model is designed for a distributed client/server environment where scalability is paramount. In this type of environment, a machine designated as the license server houses both the hardware key and the original license file. The server generates a centrally located network license file that is used by all other servers and clients that are part of the Brainware Distiller implementation.

For more information on the Brainware Distiller licensing model, please see the Product Licensing Guide on the installation CD. The document can also be found on the installation folder path …\Brainware\Brainware Distiller.
Index

Account/Group Names
   Recommended 92

Adding
   Brainware Distiller components 40

ASP.NET
   Configuration for IIS 6.0 52
   Configuration for IIS 7.0 58

Before configuring 94

Brainware Distiller
   Compatibility 19

Cairo 28
   Cairo directory 94

Cedar Workflow History Wrapper Component 36

Checking
   Installation 38

Checklist
   Installation 18

Configuration
   ASP.Net for IIS 6.0 52
   ASP.NET for IIS 7.0 58
   Core Hardware and Software 9
   Hardware sizing 9
   IIS 6.0 49
   IIS 7.0 54

DAC 91

Database
   Configuration 69
   manual post install creation 34
   platforms 8

DCOM 10, 11, 12, 13, 14, 15

Delete
   Demo file 94

Directory contents 28

Discretionary Access Control 91

Discretionary Access Control Model 91

DLLs 18

Domain user 94

Executables 29

Firewalls 16

Hardware key 94

Heap Resources
   multiple instances 114

Heap Size
   multiple instances 114

IIS 6.0
   Configuration 49

IIS 7.0
   Configuration 54

IIS 7.5
   Windows 2008 64bit R2 65

Languages
   Enabling 105

Licensing 116

Multiple RTS instances 114

Network Infrastructure 9

Novell 36

NTFS 89, 90

OCR Performance
   Maximizing 16

Operating Systems 8

Optional Components
   Install 24

Oracle
   Database Setup 31
   System Requirements 8
   Windows Authentication 31

Peer-to-Peer networking 36

RBAC 91

Registration problems 38

Removing
   Brainware Distiller components 40

Repairing
   The installation 39

Role-based Access Control 91

Role-Based Access Control Model 92

RTS Remote Administration MMC 16

Runtime Service Manager
   Configuring 94

Service Packs
   Installing 41

Shared Permissions 90

SQL Server
   Checklist 20
   Database Setup 29
   Hardware Estimate 11, 13
   System Requirements 8
   Windows Authentication 20, 31

Standalone Implementations
   Installing 37

Uninstalling
   Current Version 39
   Previous versions 21

Web.Config
   Decryption 74
   Encryption 73
   Location 29
   Options 119

Windows 7 8, 16

Windows Authentication
   configuration 76
   IIS 6 77
   IIS 7 76
   Oracle 29
   SQL Server 20, 29
   web.config 83

Windows Server 2003 8

Windows Server 2008 8

Windows Vista 8

Windows Workgroup 36

Windows XP 9, 15, 16

Windows XP SP2 8

WinWrap 8
### Appendix A  Web.Config Options

The table below contains some items which can be modified in the Web.Config with regards to enabling/disabling/customizing certain features.

<table>
<thead>
<tr>
<th>Option</th>
<th>Default Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ADOCommandExecutionTimeOut</td>
<td>Web Verifier</td>
<td>Optional attribute. Timeout in seconds for database stored procedures execution. If not specified timeout from database connection string is used.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>&lt;client ADOCommandExecutionTimeOut=10&gt;&lt;/client&gt;</td>
</tr>
<tr>
<td>assembly</td>
<td></td>
<td>Required attribute. Assembly contains custom user provider class.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>&lt;user.controller&gt;                                                                '&lt;userProvider.assembly=&quot;Brainware.Verifier.WebClient&quot; ...'</td>
</tr>
<tr>
<td></td>
<td></td>
<td>&lt;/user.controller&gt;</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Required attribute. Assembly contains custom logger provider class.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>&lt;system.logger&gt;                                                                '&lt;userProvider.assembly=&quot;Brainware.System.Logger&quot; ...'</td>
</tr>
<tr>
<td></td>
<td></td>
<td>&lt;/system.logger&gt;</td>
</tr>
<tr>
<td>batchColumnVisibility</td>
<td>Web Verifier</td>
<td>Configuration of additional columns in the Batch View:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Setting this attribute to true will display the External Group ID batch column in WVC</td>
</tr>
<tr>
<td></td>
<td></td>
<td>externalGroupIdColumn visible=&quot;true&quot;/</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Setting this attribute to true will display the External Batch Name column in WVC</td>
</tr>
<tr>
<td></td>
<td></td>
<td>externalBatchNameColumn visible=&quot;true&quot;/</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Setting this attribute to true will display the Transaction ID batch column in WVC</td>
</tr>
<tr>
<td></td>
<td></td>
<td>transactionIdColumn visible=&quot;true&quot;/</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Setting this attribute to true will display the Transaction Type batch column in WVC</td>
</tr>
<tr>
<td></td>
<td></td>
<td>transactionTypeColumn visible=&quot;true&quot;/</td>
</tr>
<tr>
<td>BatchViewPageSize</td>
<td>20</td>
<td>The number of batches to display on Web Verifier in the batch list. Any batches exceeding that count are divided into other navigation pages. The default value is 20, allowing for up to 20 batches to be shown in the Web Verifier batch list.</td>
</tr>
<tr>
<td>Option</td>
<td>Default Value</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>---------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>cacheSize</td>
<td>5</td>
<td>An optional parameter in the web.config that allows users to specify the number of documents to cache when working on a batch of documents. The cache size is associated with the loading data issue. It can avoid inaccessibility of the workstation when loading a huge amount of batches at once. Within the web.config file, set the value for the cacheSize property within the <code>&lt;system.controllers&gt;/&lt;document.controller&gt;/&lt;document&gt;</code> section. The default value is 5, which means the minimum number of document cache is 5. Changing the value to 1 will disable document caching. Example:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>class</td>
<td></td>
<td>Required attribute. Custom user provider.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>connectionStrings</td>
<td></td>
<td>Configuration connects to database.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>DocumentViewPageSize</td>
<td>4</td>
<td>The number of folders to display in the Document Tree view, when selecting Show Selected Batch. The default value, 4, denotes 4 folders to display in Show Selected Batch view; any additional batches are shown in subsequent navigation panels.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Option</td>
<td>Default Value</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>---------------</td>
<td>------------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Example</td>
</tr>
<tr>
<td></td>
<td></td>
<td><code>&lt;add key=&quot;DocumentViewPageSize&quot; value=&quot;4&quot;/&gt;</code></td>
</tr>
<tr>
<td>formEvents</td>
<td></td>
<td>Required attribute. Enable/disable mouse click event on fields and table on</td>
</tr>
<tr>
<td></td>
<td></td>
<td>the Verification view in Indexing mode.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><code>mouseClicked enabled=&quot;true&quot;</code></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Required attribute. Enable/disable tabPressed event on fields and table on</td>
</tr>
<tr>
<td></td>
<td></td>
<td>the Verification view in Indexing mode.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><code>tabPressed enabled=&quot;true&quot;</code></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Required attribute. Enable/disable itemCopied event.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><code>itemCopied enabled=&quot;true&quot;</code></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Required attribute. Enable/disable table cell select event.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><code>tableCellSelected enabled=&quot;true&quot;</code></td>
</tr>
<tr>
<td>inspectionServerTimeout</td>
<td></td>
<td>Required attribute. Time of the periodical ping the IIS server by the</td>
</tr>
<tr>
<td></td>
<td></td>
<td>process in separate mode.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><code>&lt;system.project&gt;</code></td>
</tr>
<tr>
<td></td>
<td></td>
<td><code>&lt;project. inspectionServerTimeout =&quot;00:00:20&quot; ...</code></td>
</tr>
<tr>
<td></td>
<td></td>
<td><code>&lt;/system.project&gt;</code></td>
</tr>
<tr>
<td>inspectionTimeOut</td>
<td></td>
<td>Required attribute. It is not used. Please use for this goal the session</td>
</tr>
<tr>
<td></td>
<td></td>
<td>timeout parameter.</td>
</tr>
<tr>
<td>instanceName</td>
<td>Web Verifier</td>
<td>The name of the Web module that will be shown to have access the batch list.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Example</td>
</tr>
<tr>
<td></td>
<td></td>
<td><code>&lt;client instanceName=&quot;Web Verifier&quot;&gt;&lt;/client&gt;</code></td>
</tr>
<tr>
<td>licensePath</td>
<td>“C:\My Shared License\Runtime.lic”</td>
<td>The location of the shared license file, reference documentation regarding configuration. This should point to the License Share file.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Example</td>
</tr>
<tr>
<td></td>
<td></td>
<td><code>&lt;project licensePath=&quot;C:\My Shared License\Runtime.lic&quot; mpdDistance=&quot;19&quot; mpdThreshold=&quot;60&quot;/&gt;</code></td>
</tr>
<tr>
<td>loadInSeparateProcess</td>
<td>True</td>
<td>Required attribute. Read only. The value is ‘True’ only.</td>
</tr>
<tr>
<td>maxDocumentImageResolution</td>
<td>2048</td>
<td>This value represents the compression used for sending the image quality</td>
</tr>
<tr>
<td>Option</td>
<td>Default Value</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------</td>
<td>----------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| maxDocumentImageResolution | 2048                                               | to Web Verifier IE browser. The default value of 2048 means the maximum height or width of the image to be sent to the browser. If the image exceeds this figure, the image will be compressed/reduced in proportion to accommodate the value. For example, for a 2048 x 4096 image, the image to be sent will be sent as 1024 x 2048. To disable this, set as -1. Example:<br>
```xml<br>&lt;document maxDocumentImageResolution="2048"&gt;&lt;/document&gt;&lt;/document&gt;``` |
| pathToProjectExe           | “BW \ Brainware Distiller \ bin”                   | The location of the Brainware Distiller Designer module (DstDsr.exe). Example: <br>`pathToProjectExe="C:\Program Files\Brainware\Brainware Distiller\bin\"` |
| priority                   | ERROR                                              | Set this attribute to identify tracing level. Options are,<br>- DEBUG: Full tracing of information and errors.<br>- ERROR: Errors only. Example:<br>`&lt;priority value="ERROR"/&gt;` |
| reinitScript               | True                                               | Required attribute. Assembly contains custom script (WinWrap) replacer class.                                                                                                                                  |
| remoteObjectRenewalTimeout | 60                                                 | Optional attribute. Remote object references are renewed at this time period (in seconds). Defaults to 60. Minimum accepted value is 30. The lower the number the faster unused objects free memory but this can lead to errors for long running commands. One can increase this value if some actions (i.e. field validation) take a while to finish with remoting error. Note that this value should be set in both web application config file and Brainware.System.Project.exe config file: <br>`&lt;client remoteObjectRenewalTimeout =45&gt;&lt;/client&gt;` |


<table>
<thead>
<tr>
<th>Option</th>
<th>Default Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;system.project&gt;</td>
<td></td>
<td></td>
</tr>
<tr>
<td>&lt;project.scriptReplacerAssembly=&quot;&quot; Brainware.System.Controllers&quot; ...</td>
<td></td>
<td></td>
</tr>
<tr>
<td>&lt;system.project&gt;</td>
<td></td>
<td></td>
</tr>
<tr>
<td>&lt;project.scriptReplacerClass=&quot;&quot; Brainware.System.Controllers.Project.Script.WebScriptReplacer&quot; ...</td>
<td></td>
<td></td>
</tr>
<tr>
<td>scriptReplacerClass</td>
<td>Required attribute. Custom replacer class.</td>
<td></td>
</tr>
<tr>
<td>ShowExtendedErrorMessages</td>
<td>True</td>
<td>Set this attribute to true to enable stack trace information in the error messages appearing in Web Verifier. Messages are written to the Trace Log file. Allowable values are True and False.</td>
</tr>
<tr>
<td>slogan</td>
<td>Empty</td>
<td>A text message that can be displayed on the Web Verifier browser header with corporate messages / announcements / Corporate Slogan.</td>
</tr>
<tr>
<td>Trace log/ debug file 1</td>
<td></td>
<td>It keeps the debug/trace log file under X size. Once the X size is reached, the log is recycled/deleted and a new log is created. For example, below its set to 100kb, as soon as the trace.log file went over 100kb the log file size changed to 0kb and new log messages were written.</td>
</tr>
<tr>
<td>Trace log/ debug file 2</td>
<td></td>
<td>When the file reaches X size, it is archived as trace.log.1 and a new trace.log will be created. When the trace.log exceeds size once more, trace.log.1 becomes trace.log.2 and the existing trace.log becomes trace.log.1, again a new trace.log will be created. trace.log.1 config</td>
</tr>
<tr>
<td>system.web</td>
<td></td>
<td>Standart ASP.NET configuration section: &lt;system.web&gt; &lt;sessionState mode=&quot;InProc&quot; ...</td>
</tr>
<tr>
<td>Option</td>
<td>Default Value</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------</td>
<td>-------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>Cookieless=&quot;false&quot; Timeout=10 &lt;/system.web&gt;</td>
<td></td>
</tr>
<tr>
<td>usePath</td>
<td>Required attribute. Enable/disable using pathToProjectExe parameter. Set this attribute to false to set pathToProjectExe parameter is current directory.</td>
<td></td>
</tr>
<tr>
<td>usePing</td>
<td>Obsolete. Nonrequired attribute. Enable/disable using pinging for remoting objects. It's internal attribute and should be always true in production.</td>
<td></td>
</tr>
<tr>
<td>waitLoadTimeOut</td>
<td>Required attribute. Timeout for initial loading of project.exe. This parameter is used with enable option: loadInSeparateProcess = true</td>
<td></td>
</tr>
</tbody>
</table>

Table 12-1: Options for "web.config"
Appendix B  File Permission Matrix

The table below displays the various file permissions that are used within Brainware Distiller.

<table>
<thead>
<tr>
<th>Role/Group</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Administrators</td>
<td>Administrator user with full access rights to all application modules and features.</td>
</tr>
<tr>
<td>Developers</td>
<td>The groups of users that develop, maintain, and enhance projects.</td>
</tr>
<tr>
<td>Learnset Manager</td>
<td>Typically one user in the organization responsible for maintaining the project Learnsets.</td>
</tr>
<tr>
<td>Advanced Verifiers</td>
<td>Several users responsible for identifying documents for improvements to the project Learnset.</td>
</tr>
<tr>
<td>Standard Verifiers</td>
<td>Data entry clerks responsible for document correction.</td>
</tr>
<tr>
<td>RTS Service User</td>
<td>The service account responsible for running the service for automatic document processing. Configured only on the Server machines.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Directory</th>
<th>Groups</th>
<th>NTFS Permissions</th>
</tr>
</thead>
</table>
| License Share    | Administrators
Developers
Learnset Manager
Advanced Verifiers
Standard Verifiers
RTS Service User | ☐ ☐ ☐ ☐ ☐ ☐ ☐ ☐ |
| Root Batch       | Administrators
Developers
Learnset Manager
Advanced Verifiers
Standard Verifiers
RTS Service User | ☐ ☐ ☐ ☐ ☐ ☐ ☐ ☐ |
| Common Folder    | Administrators
Developers
Learnset Manager
Advanced Verifiers | ☐ ☐ ☐ ☐ ☐ ☐ ☐ ☐ |
|                  | Standard Verifiers
RTS Service User | ☐ ☐ ☐ ☐ ☐ ☐ ☐ ☐ |
| Global Project   | Administrators
Developers
Learnset Manager
RTS Service User | ☐ ☐ ☐ ☐ ☐ ☐ ☐ ☐ |
|                  | Advanced Verifiers
Standard Verifiers | ☐ ☐ ☐ ☐ ☐ ☐ ☐ ☐ |
| Local Project    | Administrators
Developers | ☐ ☐ ☐ ☐ ☐ ☐ ☐ ☐ |
|                  | Learnset Manager
RTS Service User | ☐ ☐ ☐ ☐ ☐ ☐ ☐ ☐ |
<table>
<thead>
<tr>
<th>Directory</th>
<th>Groups</th>
<th>NTFS Permissions</th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Full Control</td>
<td>Modify</td>
<td>Read &amp; Execute</td>
<td>List Folder Content</td>
<td>Read</td>
<td>Write</td>
</tr>
<tr>
<td>Standard Verifiers</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Advanced Verifiers</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Local Learnset</td>
<td>Administrators Developers</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Learnset Manager</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>RTS Service User Standard Verifiers</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Advanced Verifiers</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Global Learnset</td>
<td>Administrators Developers Learnset Manager RTS Service User</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Advanced Verifiers Standard Verifiers</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>ASE Pool</td>
<td>Administrators Developers RTS Service User</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Learnset Manager Advanced Verifiers Standard Verifiers</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>ASSA CSV File</td>
<td>Administrators Developers RTS Service User</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Learnset Manager Advanced Verifiers Standard Verifiers</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Appendix C  Registry Options

The table below contains some items which can be modified in the Registry with regards to enabling/disabling/customizing certain features.

<table>
<thead>
<tr>
<th>Option</th>
<th>Default Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DumpProjectScriptCode</td>
<td>N/A</td>
<td>This key is available to allow Support/Certified System Administrator / Professional Services to carry out advanced troubleshooting on any issues with script running on the Web Verifier. To create the registry key to provide script dumps, follow the instructions outlined below: 1. Launch Windows Registry Editor 2. Navigate to HKEY_LOCAL_MACHINE, SOFTWARE, Brainware (or HKEY_LOCAL_MACHINE, SOFTWARE, Wow6432Node, Brainware for 64 bit systems), and Cedar location. 3. Create a new REG_DWORD (DWORD Value key) and call it DumpProjectScriptCode 4. Modify the new key created and enter the one of the following values: 3 – to enable this feature for script page export. 0 – to disable this feature. With the feature enabled the scripting engine files can be used to review any compilation problems, this is an advanced feature and requires advanced knowledge of the product.</td>
</tr>
<tr>
<td>ErrorTraceDir</td>
<td>N/A</td>
<td>The ErrorTraceDir registry key is available for those customers who wish to place the component tracing logs in a different location than the default Brainware Distiller\bin\log folder. The registry key allows the administrator to place the logs in a specific folder location separate from the core product logs. The registry setting is only applicable for the component logs, not for the core product logs. To configure a new location for Component Logs, follow the instructions outlines below: 1. Launch Windows Registry Editor 2. Navigate to HKEY_LOCAL_MACHINE, SOFTWARE, Brainware (or HKEY_LOCAL_MACHINE, SOFTWARE, Wow6432Node, Brainware for 64 bit systems), and ErrorTrace location. 3. Create a new REG_SZ (String value key) and call it ErrorTraceDir 4. Modify the new key created and enter the filepath location for component logs to be entered. Verify that the path entered exists and the service account/user has sufficient permissions to write to that location.</td>
</tr>
<tr>
<td>Option</td>
<td>Default Value</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------</td>
<td>---------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td></td>
<td>For the change to take place, exit all Brainware Distiller application, and stop any services running on the machine related to Brainware Distiller, then launch the application and all new component logs will be written in the desired location.</td>
</tr>
</tbody>
</table>
| LanguageSupportWorkflowSettingsVisible | N/A           | This registry key is used within Brainware Distiller to allow the developer to utilize advanced Language Support configuration and setting. This additional feature can be enabled via the Registry using the steps outlined below:  
1. On the server/machine where Designer is installed and used, launch the Windows Registry Editor.  
2. Navigate to HKEY_LOCAL_MACHINE, SOFTWARE, Brainware (or HKEY_LOCAL_MACHINE, SOFTWARE, Wow6432Node, Brainware for 64 bit systems), and Cedar location.  
3. Create a new REG_DWORD (DWORD Value key) and call it LanguageSupportWorkflowSettingsVisible  
4. Modify the new key created and enter the one of the following values: a. 1 – to enable this feature to allow the developer to configure advanced options for language conversion. b. 0 – to disable this feature.  
For the change to take place, exit all Brainware Distiller application, and stop any services running on the machine related to Brainware Distiller, then launch the application and all new component logs will be written in the desired location.  
To view the advanced options in Brainware Distiller Designer,  
1. Launch Designer application  
2. From the Options Menu select Settings  
3. Navigate to the Definition tab and new settings will display.  
With the settings showing, the developer can utilize additional language features which will allow them to convert words/etc to extended ASCII character set. |
| ASEEnginePoolAllowed CharDifference | N/A           | In certain instances some duplicates in the ASE/ASSA search may not be returned from the vendor/customer search. In these cases it may be that the ASSA engine perceives these as duplicates of existing entries.  
There is a configuration step that can be undertaken which can return the suspected duplicates as well. This may slightly increase the results of the ASE pool, but also return potential items which were not returned in the original search. |
<table>
<thead>
<tr>
<th>Option</th>
<th>Default Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>To configure the ASE pool to return additional likely results:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Launch Registry Editor</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Navigate to HKLM\Software\Brainware\Cedar (or HKLM\Software\Wow6432Node\Brainware\Cedar for 64 bit systems)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Create a new DWORD registry variable for ASEnginePoolAllowedCharDifference</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Close the Registry Editor</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Reanalyze the document once more and any missing entries should now appear.</td>
</tr>
<tr>
<td>HideBatchReleaseDialog</td>
<td>0</td>
<td>This key allows Support/ Certified System Administrator/ professional Services to disable the Batch Release dialog box within the Verifier, where the business does not require prompting users on next task. The registry value can be used to determine the next action carried out by users.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>The default action of the Batch Release dialog box is to verify the next invalid batch. When the dialog is suppressed, this value is maintained. To change to a different action, use the Batch Release dialog box once, then change the setting accordingly and click OK.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>To create the registry key to suppress the Batch Release confirmation screen, follow the instructions below:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Launch Windows Registry Editor</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Navigate to HKEY_LOCAL_MACHINE\SOFTWARE\Brainware\Cedar (or HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\Brainware\Cedar for 64 bit systems)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Create a new REG_DWORD (DWORD Value key) and call it HidebatchReleaseDialog</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Modify the new key created and enter the one of the following values:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 0- to enable the confirmation screen (default)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 1- to disable/ hide the confirmation screen</td>
</tr>
<tr>
<td></td>
<td></td>
<td>For the change to take place, exit all Brainware Distiller application, and then launch the application again.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>To view that the change has been implemented,</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Launch Verifier</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Verify the batch to completion – no dialog box should appear</td>
</tr>
<tr>
<td></td>
<td></td>
<td>This setting is available from version 5.3.</td>
</tr>
<tr>
<td>All</td>
<td>1</td>
<td>The ErrorTrace registry Key was introduced into core product logs to provide additional trace information on any errors or warnings in the system. The default value after installation is to record errors only related details.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Modify the registry values to set the value from 0 to either 1, 2, or 3.</td>
</tr>
<tr>
<td>Option</td>
<td>Default Value</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------</td>
<td>---------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td></td>
<td>To configure ErrorTrace All value:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>1. Launch Registry Editor</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2. Navigate to HKEY_LOCAL_MACHINE\SOFTWARE \Brainware\ErrorTrace (or HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\Brainware\ErrorTrace for 64 bit systems)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>3. Create a new DWORD registry variable for All, set to the appropriate value of either 0, 1, 2, or 3.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>4. Close the Registry Editor</td>
</tr>
<tr>
<td>MaximumDiskspace-</td>
<td>N/A</td>
<td>This registry value controls the amount of disk space allocated for component level logs on this server / workstation in MB. Setting this value to “0” has the same effect as if the value is not created at all, which is “deactivated”.</td>
</tr>
<tr>
<td>UsageMB</td>
<td></td>
<td>To configure the ASE pool to return additional likely results:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>1. Launch Registry Editor</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2. Navigate to HKEY_LOCAL_MACHINE\SOFTWARE \Brainware\ErrorTrace (or HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\Brainware\ErrorTrace for 64 bit systems)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>3. Create a new DWORD registry variable for MaximumDiskspaceUsageMB, set to the appropriate value in Mb.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>4. Close the Registry Editor</td>
</tr>
<tr>
<td>TotalDaysToKeepFiles</td>
<td>N/A</td>
<td>This registry value maintains the number of days the old component level logs are kept by the Brainware Distiller server. Setting this value to “0” has the same effect as if the value is not created at all, which is “deactivated”.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>To configure the ASE pool to return additional likely results:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>1. Launch Registry Editor</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2. Navigate to HKEY_LOCAL_MACHINE\SOFTWARE \Brainware\ErrorTrace (or HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\Brainware\ErrorTrace for 64 bit systems)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>3. Create a new DWORD registry variable for TotalDaysToKeepFiles, set to the appropriate value in numeric (total days to maintain logs – the screenshot below shows 7 days).</td>
</tr>
<tr>
<td></td>
<td></td>
<td>4. Close the Registry Editor</td>
</tr>
</tbody>
</table>
### Option | Default Value | Description
--- | --- | ---

**Table 12-2: Registry Options**

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>[Default]</td>
<td>REG_SZ</td>
<td>(value not set)</td>
</tr>
<tr>
<td>All</td>
<td>REG_DWORD</td>
<td>0x00000003 (3)</td>
</tr>
<tr>
<td>MaximumDesktopspaceMB</td>
<td>REG_DWORD</td>
<td>0x00000500 (1280)</td>
</tr>
<tr>
<td>TotalDaysToKeepFiles</td>
<td>REG_DWORD</td>
<td>0x00000007 (7)</td>
</tr>
</tbody>
</table>